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Installation and Operations Manual

Model Number: DNA1445ZW, DNA1475ZW

Description: 2MP and 4MP IR Bullet Cameras
with Intelligent Analytics

and Motorized Vari-Focal Lens



Welcome

Thank you for purchasing our Network cameral!
This user’'s manual is designed to be a reference tool for your system.
Please read the following safeguard and warnings carefully before you use this series product!

Please keep this user’'s manual well for future reference!

Important Safeguards and Warnings

. Electrical safety

All installation and operation here should conform to your local electrical safety codes.

Please check if the power supply is correct before operating the device.

The power shall conform to the requirement in the SELV (Safety Extra Low Voltage) and the
Limited power source is rated DC 12V or AC 24V in the IEC60950-1. (Power supply requirement is
subject to the device label).

Please install easy-to-use device for power off before installing wiring, which is for emergent power
off when necessary.

Please prevent the line cord from being trampled or pressed, especially the plug, power socket and
the junction from the device.

Note: Do not connect these two power supplying sources to the device at the same time; it
may result in device damage!

We assume no liability or responsibility for all the fires or electrical shock caused by improper
handling or installation.

We are not liable for any problems caused by unauthorized modification or attempted repair.

. Environment

Please don’t aim the device at strong light (such as lighting, sunlight and so on) to focus; otherwise
it may cause overexposure (It is not the device malfunction), which will affect the longevity of CCD
or CMOS.

Please transport, use and store the device within the range of allowed humidity and temperature.
Please don’t keep the device in a place which is wet, dusty, extremely hot, and extremely cold and
with strong electromagnetic radiation or unstable lighting.

Please do not allow water and other liquid falling into the camera in case that the internal
components are damaged.

Please do not allow rain or damp to the indoor device in case fire or lightning may occur.

Please keep the sound ventilation in case of heat accumulation.

Please pack the device with standard factory packaging or material with same quality when
transporting the device.

Heavy stress, violent vibration or water splash are not allowed during transportation, storage and
installation.



3. Operation and Daily Maintenance

® Please do not touch the heat dissipation component of the device directly in order to avoid scald.

® Please do not dismantle the device; there is no component which can be fixed by users themselves
in the machine. It may cause water leakage or bad image for the device due to unprofessional
dismantling. Please contact after-sale service to replace desiccant if it becomes green.

® Itis recommended to use the device with thunder proof device in order to improve thunder proof
effect.

® The grounding holes of the product are recommended to be grounded to further enhance the
reliability of the camera.

® Do not touch the CCD (CMOS) optic component directly. User may use the blower to clean the dust
or dirt on the lens surface. Please use a dry cloth wetted by alcohol to wipe away the dust gently if
it is necessary to clean.

® Always use the dry soft cloth to clean the device. If there is too much dust, please use the water to
dilute the mild detergent first and then use it to clean the device. Finally use the dry cloth to clean
the device. Don'’t use volatile solvent like alcohol, benzene, thinner and etc or strong detergent with
abrasiveness, otherwise it will damage the surface coating or reduce the working performance of
the device.

® Dome cover is an optical device, please don’t touch or wipe cover surface directly during
installation and use, please refer to the following methods to deal with once dirt is found:

®  Stained with dirt

®  Use oil-free soft brush or hair dries to remove it gently.

®  Stained with grease or fingerprint

®  Use soft cloth to wipe the water drop or oil gently to make it dry, then use oil-free cotton cloth or
paper soaked with alcohol or detergent to wipe from the lens center to outward. It is ok to change
the cloth and wipe several times if it is not clean enough.

Warning

®  Please modify the default password after login in order to avoid being stolen.

® Please use the standard accessories provided by manufacturer and make sure the device is
installed and fixed by professional engineers.

® Please prevent the device surface from the radiation of laser beam when using laser beam device.

®  Please do not provide two or more power supply modes for the device, otherwise it may cause
damage to the device.

Statement

® Please refer to the actual product for more details; the manual is just for reference.

® The manual will be regularly upgraded according to the product update; the upgraded content will
be added in the manual without prior announcement.

® Please contact the supplier or customer service if there is any problem occurred when using the

device.
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® Please contact the customer service for the latest procedure and supplementary documentation.
® There may be deviation between the actual value of some data and the value provided in the
manual due to the reasons such as the changing environment. Please refer to
the company’s final explanation if there is any doubt or dispute.

® The company is not liable for any loss caused by the operation which is not followed by the manual.

FCC Information

1. FCC conditions :

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:

® This device may not cause harmful interference;

® This device must accept any interference received, including interference that may cause
undesired operation.

2. FCC compliance :

This equipment has been tested and found to comply with the limits for a digital device, pursuant to part

15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful

interference. This equipment generates uses and can radiate radio frequency energy and, if not

installed and used in accordance with the instruction manual, may cause harmful interference to radio

communication. However, there is no guarantee that interference will not occur in a particular

installation. If this equipment does cause harmful interference to radio or television reception, which can

be determined by turning the equipment off and on, the user is encouraged to try to correct the

interference by one or more of the following measures:

® Reorient or relocate the receiving antenna.

® Increase the separation between the equipment and receiver.

® Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

® Consult the dealer or an experienced radio/TV technician for help.

Note:

Please refer to the disk for more details, check and download corresponding user’s manual and tool.
Before installation, please open the package and check all the components are included.

Contact your local retailer ASAP if something is broken in your package.

Accessory Name Amount
Network Camera Unit 1
Quick Start Guide 1
Installation Accessories Bag 1
CD 1

iii



Table of Contents

1 Device Structure ....................

..................................................................................................... 1

1.1 Device External Cable ... 1

1.2 Framework and DIMENSION .........ccoiiiiiieiiieee e 2

1.3 AL SEIUP. ...ttt et sttt sa e b ebe e eaeenaas 2

2 Device INSTallation ...........oocooiiiiiie e 5
3 Network CONfIQUIALION ......c.ooiiiiieee ettt 9
3.1 MOGIfY [P AGAIESS ...ttt 9

3.2 LOgin WEB INTEIfaCe ......oooiieieeee s 10

iv



1 Device Structure

1.1 Device External Cable

Note:
The following figure is for reference only, which is used to know the function of cable port.

There are differences about cable structure between different models, please refer to the actual
product for more details.

User may refer to the following figure for cable information. See Figure 1-1.

Figure 1-1
Please refer to the following sheet for detailed information.
No. | Port Function COREEEG Note
Name
1 AUDIO Audio RCA Output audio signal to speaker and etc.
ouT output port
2 AUDIO Audio input RCA Input audio signal, receive analog audio signal from
IN port pick up and etc.
3 LAN Network Ethernet Connect to standard Ethernet cable.
port port Note: Some series don’t support PoE.
4 I/0 I/O port - Alarm signal input/output.
5 Power port. Input DC 12V or AC 24V power.
i Note:
Power Power input / .
port Please connect the DC5.5 round port to 2-pin

converter cable when you are using AC 24V power.
Please use according to device tag.

Please refer to the follow sheet for detailed pin information.




Port Name | SN Name Note
Alarm output port. It is to output the alarm signal to the
1 ALARM NO alarm device.
B NO: normal open alarm output port.
It must be used with ALARM_COM.
/O Port 2 ALARM_COM | Alarm output public port.
3 ALARM_ IN1 Alarm input port 1. It is to receive the on-off signal from
the external alarm source.
4 ALARM_IN2 Alarm input port 2. It is to receive the on-off signal from
the external alarm source.
5 GND Ground port

1.2 Framework and Dimension

Note:

The following figure is for reference only, which is used to know the device dimension.
Please refer to the following figure for dimension information. The unit is mm. See Figure 1- 2.
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1.3 Alarm Setup

Note:
It is only supported by some series products.
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Figure 1-2
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Figure 1-3
Alarm input, output description:
Step 1
Connect alarm input device to the alarm input of I/O port cable.
Step 2

Connect alarm output device to the ALARM_OUT and ALARM_OUT_GND of I/O port cable,
Alarm output is the relay switch output; alarm output port can only be connected to NO (normally
open) alarm device.

Step 3

Open the WEB, set alarm input and output correspondingly in alarm setup. Alarm input on the
WEB is corresponding to that of the device I/O port cable. When there is alarm, alarm input
device will generate signal of high and low level. Set corresponding NO and NC inputs.

Step 4

Set alarm output on the WEB, the alarm output is corresponding to the alarm output end of the
device, this is the alarm output port of the I/O port cable.

Please refer to the following figure for alarm input and output information. See Figure 1-4.
Alarm input: When the input signal is idle or grounded, the device can collect the different
statuses of the alarm input port. The input signal is connected to 3.3V or is idle; the device
collects the logic “1”. When the input signal is grounded, the device collects the logic “0”.

Alarm Input

IFC

Collecting

GND

Figure 1-4



Please refer to the following figure for alarm output information. See Figure 1-5 and Figure 1-6.
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Figure 1-6
Mode A:
Level application. Alarm output high and low level, alarm output is OC; it needs to increase pull-
up resistance externally to work normally. Max external pull-up level is 5V, max port current is
5mA. After external pull-up resistance is increased, the default of output signal is high level
(external pull-up voltage), and it switches to low level when there is alarm output (when the
working current is 5mA, output voltage is less than 0.8V).
Mode B:
Switch application. Alarm output is used to drive external circuit, max current is 30mA, max
voltage is 5V, it is advised to add a relay if it is beyond the value.



2 Device Installation

Important

Please make sure the installation surface can min support the 3X weight of the camera
and the bracket.

H_"H.
/\_\M—_q—_
Network Camera i = |
/
Installation Screw /§ J

__,__-o-""
Expansion Boﬂ'—ﬂ”f

Installation Position Map —

Wall or Ceiling

Figure 2-1

Please see Figure 2-1.

Step 1

SD card installation (Optional)

® User may see the SD installation card slot, analog output; two direction button and reset
button after you open the lower cover.

® Insert the SD card into the slot which is shown in Figure 2-2, user may press the SD card
slightly to insert it because the card slot is elastic.

Reset Button
8D Card Slot | Two Direction Button (W)

—
i
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Analog Duéput Two Direction Button (T)

Figure 2-2



Note:

® Motorized vari-focal series devices are equipped with motorized lens by default, which
doesn’t need manual adjustment; meanwhile the devices with two direction buttons support
zoom and focus via the two direction buttons on the panel.

® User may connect the analog output port to the TV monitor to check image via analog output
cable.

® Press the reset button for 4 to 5 seconds to realize reset function for the device.

Step 2

Stick the installation position map on the designated surface where you will install the device
(wall or ceiling), then dig holes according to hole location marked on installation map.

Step 3

Open the accessories bag, take out expansion bolt and insert it into the hole you just dug.
Step 4

Open the accessories bag, take out screws. Tighten the 4 screws to fix the device on the
installation surface (wall or ceiling). User may move the device sunshield back and forth. When

you have fixed the device, you must tighten screws on sunshade.

Step 5

Plug the external cables of the device properly according to the use requirements.
Step 6

Adjust the monitoring direction of the device.

Note:

® The location of the adjusting screw may be different due to different models, please refer to
the actual product for more details.

® Please be sure to loosen the adjusting screw when adjusting the device position and angle,
tighten the adjusting screw after adjustment.

® The continuous rotation toward the same direction for the camera body has to be within 3
circles.

® The lower cover can’t be opened for a long time, besides; it can’t be opened in the humid
environment in case water mist and fog problem may happen to the device.



!
Adjusting Screw

Figure 2-3

1. Use screwdriver (in accessories bag) to loosen adjusting screw.

2. Adjust the device in all possible directions, and set its monitoring direction according to use
requirement.

3. Use screwdriver to tighten the adjusting screws.

Step 7
Waterproof connector installation for network port; see Figure 2-4 for more details.
Note:

Please implement this step if the device is equipped with network port waterproof connector and
it is used outdoors.
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Figure 2-4

1. Keep the convex groove outward and install the rubber ring into the network port, keep the
smaller hole of the rubber ring outward and install the fixing rubber ring into the main body of
the waterproof connector.

2. Pull the network cable without crystal head through main body of waterproof connector, fixing
rubber ring and waterproof locking cover, make the crystal head of network cable, and then
insert it into the network cable.



3. Put the main body of waterproof connector on the network port and rotate it clockwise to lock
the network port and waterproof connector firmly.

4. Put the waterproof locking cover on the main body of waterproof connector and rotate it
clockwise to lock the waterproof connector and waterproof locking cover firmly.



3 Network Configuration

The IP address of all the cameras is the same when leaving factory (default IP192.168.1.108), in
order to make the camera get access to the network smoothly, please plan the useable IP
segment reasonably according to the actual network environment.

3.1 Modify IP Address

IP address can be acquired and modified through quick configuration tool for the cameras which

are accessed via wired network, it needs to connect wired network to configure wireless

parameters before using wireless network cameras. In this chapter, it will introduce the approach

of modifying IP address via “Quick Configuration Tool”; also user may modify the IP address in the
network parameters of the WEB interface, please refer to the document in the disk << WEB

Operation Manual>> for more details.

Note:

Currently the quick configuration tool only supports the cameras which apply to the same

network segment with computer IP address.

Step 1 Double click the “ConfigTools.exe” and open the quick configuration tool.

Step 2 Double click the device to be configured, the system will pop out the “Login” dialog box.
Enter the IP address, user name, password and port number of the camera, and click
“Confirm”.

Note:

The default user name and password are admin and admin respectively, the default of port is

37777. See Figure 3-1 for more details.

Step 3 Modify the camera IP address on the “Net” interface, click “Save” to finish modification.
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See Figure 3-2 for more details.
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Figure 3-2

3.2 Login WEB Interface

Note:

Different devices may have different WEB interfaces, the figures below are just for reference,
please refer to the document <<WEB Operation Manual>> in the disk and the actual interface for
more details

Step 1 Open IE and input the modified camera IP address in the address bar.

Step 2 The login interface is shown below, please input your user name and password (Default
user name is admin and password is admin respectively), click “login”.
See Figure 3-3 for more details.
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IP Camera

Liseiname: I

Paszword: |
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Figure 3-3
Step 3 Install controls according to the system prompt; see Figure 3-4 for the WEB main interface.

Please modify the administrator password as soon as possible after you successfully logged in.

IP camera TR T — (————— t——
e IEEEET IR o | LT E R E

din

Figure 3-4
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Note:

This quick start guide is for reference only. Slight difference may be found in user
interface.

All the designs and software here are subject to change without prior written notice.
If there is any uncertainty or controversy, please refer to the final explanation of us.

Please visit our website or contact your local service engineer for more information.
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Important
The following functions are for reference only. Some series products may not
support all the functions listed below.



1 Network Config

1.1 Network Connection

Network camera and PC connection mainly has two ways, see Figure 1- 1 and Figure 1-2.
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Figure 1-2

Before you access network camera via the Internet, you need to have its IP address. User can use
Config Tool to search IP of the network camera. Please refer to Config Tool manual.

1.2 Login

It needs to install WEB plug-in when you use WEB client for the first time, the exact operation steps are

shown as follows:
Open IE and input network camera address in the address bar. (The factory default IP address is

192.168.1.108).



After successful connection, the login interface is shown as in Figure 1-3; input your user name and
password. Default factory username is admin and password is admin.

IP Camera

Username:

Passwaord:

Figure 1-3

The system will display “Update Password” prompt box for your first login, users need to modify the
password and save it properly.

First login, suggest updating password.

Mew Passwaord

Caonfirm Password

[] Don't show me again

Ok Cancel

Figure 1-4

After successful login, you may see the interface shown as in Figure 1-5.
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Figure 1-5

Click on “Please click here to download and install the plug-in”. The system pops up warning information
to ask you whether run or save this plug-in. See Figure 1-6.

Do you want to run or save this file?

Mame: webplugin,exe
Type: Application, 1,03ME

From: 10.10.4.198

Run Il Save ][ Cancel ]

YWhile files from the [ntermet can be uzeful, this file type can
| | :
B potentially harm pour computer. If you do nat trugt the zource, do not
S0 unoar zave thiz software, What's the risk?

Figure 1-6



You must either run or save the file to local and install it. Follow the following steps. Click on run, you
will see Figure 1-7and Figure 1-8.

Ready to Install
Setup is now ready to begin instaling webplugin.exe on your computer,

Click Install to continue with the instalation.

L Install ]I Cancel

Figure 1-7



bplugin.exe

Installing
Please wait while Setup installs webplugin.exe on your computet,

Registering files. ..

Cancel

Figure 1-8
When plug-in installation completes, the installation page closes automatically. The web-end will refresh
automatically, and then you can view video captured by the camera.

IP Camera
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Figure 1-9



2 Live

After you logged in, you can see the live monitor window. See Figure 2-1.

IP Camera
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Figure 2-1

There are four sections:

® Section 1: Encode setup bar

® Section 2: System menu

® Section 3: Window function option bar
® Section 4: Window adjust bar

2.1 Encode Setup

Note: Some series don’t support sub stream 2.
The encode setup interface is shown as in Figure 2-2.

Sub Strearm 1 =ILESCET R Frotocol m

Figure 2-2

Please refer to the following sheet for detailed information.




Parameter Function

Click it to enable main stream video monitoring and click again
to disable it. Generally for storage and monitor.

Sub Stream 1 Click it to enable Sub Stream 1 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

Sub Stream 2 Click it to enable Sub Stream 2 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

You can select stream media protocol from the dropdown list.
There are three options: TCP/UDP/Multicast

Main stream

Protocol

2.2 System Menu

System menu is shown as in Figure 2-3.
Please refer to chapter 2 Live, chapter 3 PTZ, chapter 4 Playback, chapter 5 Setup, chapter 6 Alarm,
chapter 7 Log out for detailed information.

Live PTZ Playback Se Alarm Logout
Figure 2-3

2.3 Video Window Function Option

The interface is shown as below. See Figure 2-4.

Figure 2-4
Please refer to the following sheet for detailed information.
SN Parameter | Function
1 Relay-out It shows if there is any alarm output, status description is as
follows:

® Red: means there is alarm output.
® Grey: means alarm is over.
Click on the button to force alarm to be on or off.




2 Digital ® When the video is in the original status, click it you can
Zoom select any zone to zoom in. In the non-original status,
you can drag the zoom-in zone in specified range. Right
click mouse to restore previous status.
® (Click it; you can use the middle button of the mouse to
zoom in/out the video size.
3 Shapshot Click on the button to snapshot, save picture to path in Ch.
5.1.2.5.
4 Triple Click it to take snapshot upon the video at the frequency of
snapshot one picture per second. All images are saved to path in Ch
5.1.2.5.
5 Record Click it to record the video. All videos are saved to path in
Chapter 5.1.2.5.
6 Easy focus | Click it, you can see there are two parameters on the preview
video: AF Peak and AF Max.
AF Peak: It is to display the video definition during the focus
process.
AF Max: It is the most suitable value for the video definition.
The close the AF Peak and AF Max is, the better the focus
effect is.
7 Audio Turn on or off audio when you are monitoring.
8 Talk Click it to start or end bidirectional talk.
9 Help Click it to open help file.

2.4 Video Window Setup

The interface is shown as in Figure 2-5.

2.4.1 Image Adjustment

& oon 53 Rl 4o £ ©

ONONONONORONGEO)

Figure 2-5

See Figure 2-6 for image adjustment.




Click this button to display/hide image control interface. Click it to open picture setup interface. This

Image Adjustment

Figure 2-6

interface is on the top right pane.

Please refer to the following sheet for detailed information.

64

It is to adjust monitor video
contrastness.

It is to adjust monitor video
hue.

It is to adjust monitor video
saturation.

Reset

Restore brightness,
contrastness saturation and
hue to system default setup.

Parameter Function

Video It is to adjust monitor video Note:

setup brightness. ® All the operations here apply
to WEB end only.

® Please go to Setup-
>Camera->Conditions to
adjust corresponding items.

2.4.2 Original Size

Click this button to go to original size. It is to display the actual size of the video stream. It depends on

the resolution of the bit stream.

2.4.3 Full Screen

Click it to go to full-screen mode. Double click the mouse or click the Esc button to exit the full screen.

9



2.4.4 Width and Height Ratio
Click it to restore original ratio or suitable window.

2.4.5 Fluency Adjustment

There are three levels of fluency for you to select (Realtime, Normal, and Fluency). The default is
normal.

2.4.6 Rules Info

Click the button, preview image will display intelligent rules after enabling; it is “enable” by default.
2.4.7 Zoom and Focus

Click this button and the focus zooming interface appears on the right of preview interface, as shown in

Figure 2-7, click left mouse button to adjust focus zooming configuration.

Note:

« The product series which support motorized zoom, synchronous focus and back focus have this
button.

+ Auto-focus after zoom and focus adjustment.

2.4.8 Fisheye/Trigger Track

Click the button, installation mode and display mode interface will show up on the right of the preview

interface, see Figure 2-8 and Figure 2-9, single click to switch different installation modes and display

modes for fisheye, or switch different display modes for trigger track, it is enabled by default.

Note:

It is only supported by some models.

Zoom and Focus

Speed P

Focus Speed )

Mear Far

Restore All

Regional Focus

Figure 2-7
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Parameter

Function

Adjust the focal length of the lens by clicking or long pressing “+”“-"buttons.

Zoom
The speed is used to adjust the length of one step during single click.
Focus Adjust the sharpness of the lens by clicking or long pressing“+”. “-” buttons.
Step length is used to adjust the length of one step with one click.
Click to adjust the image definition automatically.
Auto- Note:
focus ’
Other lens operations are not allowed during the process of auto-focus.
Reset the lens to zero position to eliminate the accumulative error of lens.
Reset Al | NOt®: _ . _ .
Please reset when the image adjustment is not clear or operating zoom focus many
times.
Refresh Synchronize the location of drag slider of lens and zoom focus after hardware zoom
focusing.
Regional | Click it and use the mouse to select a zone, then the device can auto focus within the
Focus specific region.

In-ceiling Mount Wall Mount Ground Mount

Installation Mode Installation Mode

P

7 s

Installation Mode

#a

Display Mode

Display Mode

el
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Figure 2-8

parameter

Note

Installation Mode

Three modes which are ceiling mount, wall mount and ground mount.

Display Mode

It represents the display mode of the current image (default supports original
image mode), the display modes may be different according to different
installation modes. It is shown as follows:

e Ceiling: 1P+1. 2P, 142, 1+3. 1+4. 1P+6. 1+8.
e Wall: 1P, 1P+3. 1P+4. 1P+8.
e Ground: 1P+1. 2P, 1+3. 1+4. 1P+6. 1+8.

Note:
The default displays original image mode when switching installation mode.

In-ceiling/Wall/Ground

O

image

Original It menas the original image without de-warpping

In-ceiling/Ground

360°expanded rectangular panorama + independent
sub image, the sub image and the subbox in the
expanded rectangular panorama support zoom and
movement, for the expanded rectangular panorama
also supports left and right starting point movement.

bmd FY =R

Two related 180° expanded rectangular pictures, two
subwindows form 360° panorama anytime, which is
also called “dual panorama”. Two expanded
op rectangular pictures both support left and right
movement starting point, which are also linked by
eachother.

il

Original image + 2 independent sub images, both the

sub image and the subbox in the original image

’é—‘ support zoom and movement. The original image also

142 supports changing starting point by rotation (no such
display mode for ground installation).

Q]

F Origir_mal image + 2 independen’g sub imageg, bolth the
Q sub image and the subbox in the original image
143 support zoom and movement. The original image also
supports changing starting point by rotation

Original image + 4 independent sub images, both the
= sub image and the subbox in the original image

144 support zoom and movement. The original image also
supports changing starting point by rotation

12




parameter

Note

1P+6

360°expanded rectangular panorama +6 independent
sub image, both the sub image and the subbox in the
expanded rectangular panorama support zoom and
movement, for the expanded rectangular panorama
also supports left and right starting point movement.

148

Original image + 8 independent sub images, both the
sub image and the subbox in the original image
support zoom and movement. The original image also
supports changing starting point by rotation

Wall

1P

From left to right 180° expanded rectangular
panorama, which supports up and down movement
and changes vertical angle of view.

ﬁ

1P+3

180° expanded rectangular panorama+3 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

&

1P+4

180° expanded rectangular panorama+4 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

B

1P+8

180° expanded rectangular panorama+8 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

Display Mode

Figure 2-9

Enable the trigger track on the interface of tripwire or intrusion, and draw the rule of tripwire or intrusion,
the scene of trigger track window will change according to the moving object when it triggers rule alarm
until the moving object disappears from the view range of the camera. Please refer to “5.3.4 IVS” for
more details about the rules drawing and parameter config of tripwire and intrusion.

Trigger track includes three modes which are 1P, 1P+3 and 1P+5.

13




° E 1P: Original picture

o . 1P+3: Original picture and three trigger track windows, it can adjust the location and size of

three trigger track windows on the original picture.

o | 1P+5: Original picture and five trigger track windows, it can adjust the location and size of

five trigger track windows on the original picture.

14



3 PTZ Control

Here you can view direction keys, speed, zoom, focus, iris, preset, tour, pan, scan, pattern, aux on, off
and PTZ setup button. See Figure 3-1.

Note:

Before PTZ operation, please make sure you have properly set PTZ protocol. (Please refer to Ch. 5.5.3).
Currently only IPC-HFXXXX series and —PT series products can support PTZ function.

Parameter Note

o ® PTZ supports eight directions: left/right/up/down/upper left/upper
PTZ direction right/bottom left/bottom right.

It controls rotation speed. The longer the step length, the higher the speed.
Step length control PTZ, zoom, focus and iris.

Use mouse to draw a box in monitoring video, PTZ will rotate and focus to
Quick Position | quickly positioning.

Speed

IP Camera

m
‘_

Po L

Figure 3-1
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©00
0G0

speedr1-2): B
e Zoom

PTZ Settings

Scan gj

- Start W Stop

Figure 3-2

PTZ setting interface is shown as in Figure 3-3.
Here you can set scan, preset, tour, pattern, assistant function and light and wiper plus view coordinate.

3.1 Scan

Scan interface is shown in Figure 3-4.

PTZ Settings

Figure 3-3
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PTZ Settings

P Start B Stop

Set Left Set Right

Figure 3-4

Steps to scan are:

I Set Left lSetRight

Step 1. Click on Set button, display icon.

Step 2. Move via direction key to select left, click on Set Left to set left border of camera

Step 3. Move via direction key to select right, click on Set Right to set right border of camera.

Step 4. Complete scan path setup.

3.2 Preset

Preset interface is shown in Figure 3-5.
PTZ Settings

Figure 3-5

Steps to preset are:

Step 1. In preset box, input preset value.

Step 2. Click on Go to, camera rotates to preset position.

Step 3. Use direction key to rotate camera, and in preset box input preset value.
Step 4. Click on Add to add a preset. Range of preset relates to PTZ protocol.

3.3 Tour

17



Tour interface is shown in Figure 3-6.

PTZ Settings

Tour -

P Start W Stop

Figure 3-6

Steps to tour are:

Step 1. In tour box, input tour path value.

Step 2. Click on Add. Range of tour relates to PTZ protocol.
Step 3. In preset box, input preset value.

Step 4. Click on Add as to add a preset in this tour. If click on Del, it deletes this preset in tour.
Note:

You can add more than one preset here, or delete more than one preset.

3.4 Pattern

Pattern interface is shown in Figure 3-7.

PTZ Settings

5
EXIECR

Figure 3-7

Steps to set pattern are shown as follows:

Step 1

Input pattern serial number value in the box, click “Add” and it will display “Start Rec” and “Stop Rec”.
Step 2

Click “Start Rec” to implement a series of operations such as zoom, focus, iris, direction and so on.
Step 3

18



Click “Stop Rec” to complete the setting of a pattern path.

Step 4

Click “Start” and it will start pattern according to the pattern path which has been set; click “Stop” and
the pattern ends.

3.5 Assistant

Assistant interface is shown in Figure 3-8.

PTZ Settings

Assistant

AL On Al Off

Figure 3-8

Steps to assistant are:

Step 1. In assistant box input assistant value.

Step 2. Click on Aux On to turn on aux function.
Click on Aux off to turn off aux function.

3.6 Light/ Wiper

Light wiper interface is shown in Figure 3-9.

PTZ Settings

Light Wiper -

Enable Disahle

Figure 3-9

Steps to light wiper are:
® (Click on Enable to enable light wiper function.
® C(Click on Disable to disable light wiper function.
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4 Playback

Web client playback supports video playback and picture playback.
Note:
Before playback, user shall set storage management as in Ch. 5.4.

4.1 Playback

The playback interface is shown as in Figure 4-.

IP Camera (ST S T S SN T
e IO

File Type

stasre

T < BT

‘Sun Mon Tue Wed Thu Fri Sat

1
213|456} 7]8
910 1112 13|14 15

16 17[18[19 20 21|22

23124 1 25/26 27|28 29

3{\

Record Type Bl Al B General W Motion I Alam - E Manual B

Figure 4-1

There are four sections:

Section 1: Function of play
Section 2: Playback file
Section 3: Play time cut
Section 4: Record type
Section 5: Progress bar
Section 6: Assistant function
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4.1.1 Function of Play
The function of play is shown as in Figure 4-2 and Figure 4-3.

0000 O =0

©Oe ®e e & O 6-1

Figure 4-2

00000 O =0

D2 e & ® O @z

Figure 4-3
Parameter Function
© Pla When you see this button, it means pause or not played record. Click on this
y button, switch to normal play status.
@ Stop Click this button to stop playing.

® Play by

Click on this button to go to next frame.
Note:

frame
You shall pause record when you use this function.
® Slow Click on this button to play slowly.
©® Quick Click on this button to play quickly.
® Silent When this button displays, it means audio is silent. Click on this button to switch
back to normal.
® Volume Click on left mouse to adjust volume.

-1 Fisheye

Click this button and fisheye device can adjust display mode according to
different installation mode during the process of playback.

-2 Rule Info

Click the button and it will playback and display intelligent rules and object
detection box if the video is equipped with intelligent rule info after the function is
enabled, it is off by default.
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4.1.2 Playback File
In calendar, blue date represents data currently has video record or snapshot. See Figure 4-4.

¢ 2013 [

Sun Mon Tue Wed Thu Fri Sat

Figure 4-4
Parameter Function
File Type e Select “fjav”, as Yideo playback.
e Select “jpg” as picture playback.
Data Source Default is SD card.

Step 1. Click on data in blue, time axis displays record file progress bar in color. While, green represents
normal record, yellow represents motion detect record, red represents alarm record, and blue
represents manual record.

Step 2. Click on certain time on progress bar, playback starts from this time. See Figure 4-5.

Figure 4-5

Step 3. Click on file list

Step 4. Double click on file in list, playback this file and display file size, start time and end time.
See Figure 4-6.

, select date file will be displayed in list.
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00 - 00 - 00 - 23 - 59 - 59 [fe)
General, Event, Alarm, Manual | -

Download Format @ dav @ mp4

Start Time  File Type

|
o

EE
00000000

17:00:54

SRR [+
Begin Time:
End Time:

File Size:

Figure 4-6

Parameter

Function

HSearch

It means records within searched start time and end time on the date.

Record Format

There are two formats: dav, mp4.

Download

® C(Click the download button and download file to path in Ch. 5.1.2.5.
® System does not support download and playback at the same time.
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Parameter Function

& Back Click on back button to go to calendar interface.

4.1.3 Playback Cut

Note:

Playback cut function will automatically pause playing record as playback cut and playback cannot be at
the same time.

Step 1. Click on start time to cut on time axis. This time must be within progress bar range.

—_—

Step 2. Move mouse to cut icon 5‘5 . You will be ask to select start time. Click on cur icon gﬁ as

finish cutting.

Step 3. Click on playback cut end time on time axis. This time must be within progress bar range.

— —
Step 4. Move mouse to cut icon-& you will be asked to select end time. Click on cut icon .& as
finish cutting.

Step 5. Click on Save button to save file cut to path in Ch 5.1.2.5. See Figure 4-7.

00:00:00-00:00:00 B

Figure 4-7

4.1.4 Record Type

After checking record file type, only selected file will be displayed in progress bar and file list. Users can
also select the record type to be displayed via the dropdown box which is above the file list. See Figure
4-8.

Record Type [ Al [ General M Motion ® & Alarm & Manual W
Figure 4-8

4.1.5 Progress Bar

24



L (D2dhe | Ozhie O 1hr § O20min

Figure 4-9
Parameter Function
Click on it, means video in past 24 hours.
24 hours
) ick on it, means video in past 2 hours.
O b hours Click on it ideo in past 2 h
r ick on it, means video in past 1 hour.
©1br 1 hour Click on it ideo in past 1 h
(9 30min - Click on it, means video in past 30 min.
30 min

4.1.6 Assistant Function
Video playback assistant function is shown in Figure 4-10.

Figure 4-10

Parameter Function

e C(Click on it, video in playback status if is in original size, user can
zoom in any area, If it is not in its original size, right click mouse to
Digital Zoom restore its original size.

e Click on this button, you can scroll to zoom in.

E Click on this button, you can snapshot video under playback status.
Snapshot Snapshot will be saved to path in Ch. 5.1.2.5.

4.2 Picture Playback

Web client picture playback interface has the following three functions:

Parameter Function

1 Play function bar
2 Playback file bar
3 Snapshot type bar

See Figure 4-11.
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@
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Data Src _SDCard E

e <

Sun Mon Tue Wed Thu Fri Sat

©

Snapshot Type [ Al General W B Event ® Bl Alam

Figure 4-11

4.2.1 Play

oo

Figure 4-12

Default icon is m and it means pause or not played picture. Click on play button to switch to

normal play status. Ilcon become m

Click on it to pause.
4.2.2 Playback File
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Step 1. Click on file list

BEIERS A S0 Card i
¢ 2013 B

Sun Mon Tue Wed Thu Fri Sat

Figure 4-13

, select snapshot file of the date.

Step 2. Double click on file in list, to play this snapshot.

Parameter

Function

n Search

It means all snapshot files within the start time and end time of selected date.
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Parameter

Function

mDownIoad

Click the download button to open snapshot file or directly download to local
according to the browser types.

€« Back

Click on back button to return to calendar interface and re-select time.

00 : 00 : 00 - 23 : 59 : 59 jeY

Stat Time  File Type
13:23:16 )

13:24:55

=
o

©
o
©
o
©
o
©
o
©
o

g

M a1/1p p

Figure 4-14

4.2.3 Snapshot Type
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After checking snapshot file type, in file list only display file of selected type. Users can also select the
snapshot type to be displayed via the dropdown box above the file list. See Figure 4-.

Snapshot Type E All General Event Il Alarm

Figure 4-15
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5 Setup

Web client setup support camera, network, time, storage, system and system info view.

5.1 Camera

The camera setting includes conditions, profile management, zoom and focus.

5.1.1 Conditions

Note:

The camera parameter may be different according to different models, please refer to the actual product
for more details.

5.1.1.1 Picture

Note:

The device which supports true WDR fails to support long exposure when true WDR is enabled.

Step 1

Select “Setup > Camera > Conditions > Picture” and the system will display the “Picture” image which is
shown in Figure 5-1.

IP Camera

Conditions  JProfile Management] Zoom and Focus.

> Video

Profile  Day E

| shle Standard []

» Exposure

> Audio

Network Brightness [=] D
Event » Backlight Contrast [=] D
Saturation [=] D 50

Storage » WB

System
it » Day & Might s
Information

» IR Light Gamma [=]

Mirror ) ON @ OFF

Flip 0°

Default || Refresh || Save

Figure 5-1
Step 2
Set picture parameters; please refer to the following sheet for more details about parameter setting.
Parameter Note
Style It is to set the picture style, which includes standard, soft and vivid.
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Parameter

Note

Brightness

It is to adjust the image overall brightness via linear adjustment mode.
The larger the number is, the brighter the picture is, and on the contrary it
is opposite. The picture get blurry easily when the value is set too big.

Contrast

It is to adjust the picture contrast. The bigger the value is, the bigger the
bright contrast becomes, and on the contrary it is smaller. The dark area
becomes darker and the bright area becomes overexposed easily when
the value is set too big. The picture becomes blurry when the value is set
too small.

Saturation

It is to adjust the color darkness and lightness. The color becomes darker
when the value is bigger; on the contrary it becomes lighter. The value
causes no influence to the overall brightness of the image.

Sharpness

It is to adjust the sharpness level of the picture edge. The bigger the
sharpness value is, the more obvious the image edge becomes, the image
is likely to generate noise more easily when the value is set too big.

Gamma

It is to change image brightness and improve the dynamic display range of
the image via nonlinear adjustment mode. The bigger the value is, the
brighter the picture becomes, and on the contrary it is opposite.

Mirror

After mirror is enabled, the monitoring image will be displayed invertedly.

Flip

It is to change the display direction of the monitoring image.
It includes following options:
e Normal: The monitoring picture is normally displayed.

e Flip mode 1: The monitoring picture is displayed with clockwise
rotation 90°

e Flip mode 2: The monitoring picture is displayed with anticlockwise
rotation 90°

e 180°: The monitoring picture is displayed upside down.
Note:

Please set the video resolution as 1080P or lower when applying flip mode
for some devices.

EIS

It can realize electronic anti-flicker function via comparison algorithm of
image difference, which can effectively solve the problem of image jittering
during application and it can make the image clearer.

Step 3

Click “Save” and complete the image parameter config of the camera.
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5.1.1.2 Exposure
Step 1

Select “Setup > Camera > Conditions > Exposure”. The system will display the “Exposure” interface
which is shown in Figure 5-2.

IP Camera

Conditions Profile Management§ Zoom and Focus

Profile | Normal [~

> Audio e Anti-flicker | Outdoor

[]

» Backlight

Network

Event Autolis @ ON () OFF
Storage » WE B .
3DNR@ ON () OFF

Grade [=] 0 50

System » Day & Night
Information v IR Light

‘ Default ‘ ‘ Refresh | ‘ Save |
Figure 5-2
Step 2
It is to set the exposure parameter, please refer to the following sheet for more detalils.
Parameter Note

® Qutdoor: You can switch to exposure mode when it is in
outdoor mode, it can realize the result in the corresponding
exposure mode.

® 50Hz: When the current is 50Hz, system can auto adjust the
Anti-flicker exposure according to the environment brightness in case
there is any stripe.

® 60Hz: When the current is 60Hz, system can auto adjust the
exposure according to the environment brightness in case
there is any stripe.




Parameter

Note

Mode

It is the camera exposure mode.
Note:

® When “Anti-flicker” is “Outdor”, the “exposure mode” can be
set as “gain priority” or “shutter priority” mode.

® Different devices have different exposure modes; please
refer to the actual interface.

It includes the following options:

® Auto: It can auto adjust the image brightness according to
the environment.

® Gain priority: The device can auto adjust according to the
gain range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the gain value has reached to upper limit
or lower limit, which is to make the image reach the best
brightness.

® Shutter priority: The device can auto adjust according to the
shutter range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the shutter value has reached to upper
limit or lower limit, which is to make the image reach the best
brightness.

® |[ris priority: Iris value is fixed, the device can auto adjust the
shutter value if the image brightness fails to reach effect and
the shutter value has reached the upper limit or lower limit,
the device can auto adjust the gain value to make the image
reach the best brightness.

® Manual: It is to manually set gain value and shutter value,
adjust the the displayed brightness of the image.

Auto Iris

It can set the parameter when the camera installs auto iris.

® The lens iris can auto adjust the size according to the
environment after auto iris is enabled, then the image
brightness will change accordingly.

® The iris value reaches the max when disabling auto iris, the
lens iris will not change according to the environment
brightness.

3D NR

It is to process the image with multiframe (at least two frames), it
can realize noise reduction of the image by using the interframe
information between the previous and latter frame.

Grade

It can set the parameter when “3D NR” is enabled.
The bigger the grade is, the better NR effect it can realize.
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Step 3
Click “Save” to complete the parameter config of camera exposure.

5.1.1.3 Backlight

Backlight mode can be divided into BLC, WDR and HLS.

BLC: it can avoid cucoloris phenomenon of the darker area in the backlight environment.

WDR: It can suppress the overbright area and compensate darker area by enabling WDR, which can
make the overall image clear.

HLC: It is to weaken the high light, which can be applied in the areas such as toll gate, entrance and exit
of the parking lot and etc. As for extreme light, it can snapshot the human face in the dark environment
and it can realize better effect for the details of the plate number.

Step 1

Select “Setup > Camera > Condition > Backlight”, the system will display the interface of “Backlight”
which is shown in Figure 5-3.

IP camera

Profile. Normal
>

A A » Picture
> Audio 3 Mode | OFF E
Network > Pt bt —~— » Exposure

Event T—— » Backlight
o ==

Storage » WB
System » Day & Night

Information » IR Light

‘ Default H Refresh H Save ‘

Figure 5-3
Step 2
Set the backlight parameter.
® When the “Mode” is set as “Scene Self-adaptation”, the system will auto adjust the image

brightness according to the environmental brightness, which is to make the object display clearly in
the scene.

® When the “Mode” is set as “BLC”, it can select default mode or customized mode.
€ When selecting “Default” mode, the system can realize auto exposure according to the
environment, which is to make the image in the darkest area clear to be seen.
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€ When selecting “Customized” mode, the system can realize exposure upon the selected area
after it set customized area, which is to make the image of the selected area reach
appropriate brightness.
® When the “Mode” is set as “WDR?”, it will lower the brightness of the area with high brightness and
enhance the brightness of the area with low brightness, which is to make the objects in both high
brightness and low brightness area display clearly.
Note:
There may be video loss of a few seconds when the camera is switched from non WDR mode to WDR
mode.
® When the “Mode” is set as “HLC”, the system will constrain the brightness of the area with high
brightness and decrease the size of the halo area, which is to lower the brightness of the whole
image.
Step 3
Click “Save” to complete the config of the backlight mode.

5.1.1.4 WB

WB is used to restore the white object in the scene by the camera, after WB mode is set, it can make
the white object look white in different environments.

Step 1

Select “Setup > Camera > Conditions > WB”, the system will display the interface of “WB”, which is
shown in Figure 5-4.

IP Camera

Profile  Mormal

R, Pich
> Audio : B Ficure Mode | Auto
Network & =~ B — » Exposure

Event 5 T » Backlight
System » Day & Night
Information

storage

» IR Light

‘ Default ‘ ‘ Refresh || Save ‘

Figure 5-4
Step 2
Set WB mode.
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When the “Mode” is set as “Auto”, the system can auto compensate white balance upon different
color temperatures, which is to make the image color normal.

When the “Mode” is set as “Natural”, the system can auto compensate white balance to the scene
without artificial light, which is to make the image color normal.

When the “Mode” is set as “Street Lamp”, the system can auto compensate white balance to the
outdoor scene at night, which is to make the image color normal.

When the “Mode” is set as “Outdoor”, the system can auto compensate white balance to the most
outdoor scenes with natural light and artificial light, which is to make the image color normal.
When the “Mode” is set as “Manual”, it can manually set the value of red gain and blue gain; the
system can compensate the different color temperatures in the environment according to the
settings.

When the “Mode” is set as “Regional Custom”, it is to set customized area, the system can
compensate white balance to different color temperature of the images in the area, which is to
make the image color normal.

Step 3
Click “Save” to complete the config of WB mode.

5.1.1.5 Day & Night

It is to set the switch between color mode and black & white mode.

Step 1

Select “Setup > Camera > Conditions > Day & Night” and the system will display the interface of “Day &
Night”, which is shown in Figure 5-5.

IP cCamera

Conditions
Profile | Normal

Network - — . 5 A E S Sensitivity Middle

{ =]
2 wid TN
> Audio B’ Ficure Mode Auto [+]
[]
[=]

i =
Event — » Backlight Delay 65

Storage . 3 » W8

» Day & Night

system

Information » IR Light

| Default || Refresh H Save ‘

Figure 5-5
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Step 2

Set day & night parameter; please refer to the following sheet for more details.

Parameter

Note

Mode

It is to set the camera image displayed as color or black & white mode.

Note:

The setting of “Day/Night Mode” is not affected by the setting of “Profile

Management”.

It includes the following options:

® Color: The camera image is displayed as color image.

® Auto: The camera can auto select color image or black & white image
to be displayed according to the environmental brightness.

® Black & white: The camera image is displayed as black & white image.

Sensitivity

The parameter can be set when the “Day/Night Mode” is “Auto”.
It is to set the sensitivity of the switch between image color display and
black & white display.

Delay

The parameter can be set when the “Day/Night Mode” is “Auto”.

It is to set the switch delay between image color display and white & black
display. The smaller the delay is, the faster of the switch becomes between
color display and black & white display.

Step 3

Click “Save” to complete the config of day/night mode.

5.1.1.6 Defog

The image quality will become weak when the device is in the environment with fog or haze, you can

enable defog function to adjust the image definition.

Step 1

Select “Setup > Camera > Conditions > Defog” and the system will display the interface of “Defog”
which is shown in Figure 5-6.
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IP camera

p—
— Profile  Day
> Video
> Audio » Picture Mode | OFF [=]
Network = £, _ - » Exposure
Event T— » Backlight
Storage g 4 » WB

System » Day & Night

0 —y

Figure 5-6

Step 2

It is to set defog mode according to the actual scene.

® When the “Mode” is set as “Manual’, it is to manually set intensity and air light mode, the system
will adjust the image definition according to the intensity and air light mode which have been set
previously. As for air light mode, you can set manual or auto.

® When the “Mode” is set as “Auto”, the system will auto adjust the image definition according to the
actual scene.

® When the “Mode” is set as “Off”, then the defog function is disabled.

Step 3
Click “Save” to complete the config of defog mode.

5.1.1.7 IR Light

You can directly set the mode of IR light if the device is equipped with IR light.

Step 1

Select “Setup > Camera > Conditions > IR Light” and the system will display the interface of “IR Light”
which is shown in Figure 5-7.

38



IP Camera

Conditions

Profile | Normal

| » Picture Mode SmartiR E|
Network — = z s 3 » Exposure

Event 3 s » Backlight
» SE
Storage 9 B swe

System E » Day & Night

_ .
Information # » IR Light
. —
.

Figure 5-7
Step 2
It is to set IR light mode according to the actual scene.
® When the “Mode” is set as “Manual”’, it can manually set the brightness of IR light; the system wiill
realize light compensation to the image according to the IR light intensity.
® When the “Mode” is set as “Smart IR”, the system can adjust the light brightness according to the
actual scene.
® When the “Mode” is set as “Zoomprio”, the system can auto adjust the IR light according to the
brightness change of the actual scene.
€ The system will enable near light by priority when the actual scene becomes dark, the system
will enable the far light when the near light fails to meet the requirement of scene brightness
even if it is adjusted to the brightest.
€ The system will adjust far light brightness by priority to off and then adjust the brightness of
near light when the actual scene becomes bright. The system will always disable far light
when the focal length of the lens is adjusted to a certain wide angle, which is to avoid near
overexposure. Meanwhile, it can manually set light compensation to slightly adjust the
brightness of IR light.
® When the “mode” is set as “Off”, it will not enable the IR light.

Step 3
Click “Save” and complete the config of IR light.

5.1.1.8 Profile Management

Step 1

Select “Setup > Camera > Conditions > Profile Management” and the system will display the interface of
“Profile Management”.
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Step 2

Set profile management.

® When the “Profile Management” is set as “Normal”, the system will monitor according to the normal
config.

IP Camera

Camera Conditions Profile Management Zoom and Focus

Profile Management @ Normal € Full Time ¢ Schedule
> Video

> Audio Default ‘ ‘ Refresh | ‘ Save

Network
Event
Storage
System

Figure 5-8
® When the “Profile Management” is set as “Full Time”, you can select “Always Enable” in “Day” or
“Night’, the system will monitor according to the config of “always enable”.

IP Camera

Camera Conditions Profile Managementl]  Zoom and Focus

g Frofile Management ¢ Normal ¢ Full Time (" Schedule
> Video
Always Enable Day =
> Audio

Network ‘ Default ‘ | Refresh ‘ | Save

Event
storage
System

Information

Figure 5-9
® When the “Profile Management” is set as “Schedule”, you can set some period as day and another
period as night, for example, if it sets 0:00~12:00 as day, 12:00~24:00 as night, then the system will
monitor by adopting corresponding config in different periods.

IP camera

Camera Conditions Profile Management Zoom and Focus

Profile Management € Mermal ¢ Full Time & Schedule
> Video

> Audio

Network Period setting Q E

Event 0.00 4.00 8:.00 12:.00 16:00 2000 2400
Storage EDay W MNignt
Zisiam | Default ‘ | Refresh ‘ | Save ‘

Information

Figure 5-10
Step 3
Click “Save” to complete the settings of profile management.
Note:

Click “Default” to restore the device to default config; click “Refresh” to check the latest config file of the
device.
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5.1.1.9 Zoom and Focus

Note:

Only motorized vari-focal devices support focus and zoom function.

Step 1

Select “Setup > Camera > Conditions > Zoom and Focus” and the system will display the interface of
“Zoom and Focus” which is shown in Figure 5-11.

IP camera T T TN T AT T
®

Camera Conditions

Conditions

Profile Management Zoom and Focus

> Vid

> Audio
Network
Event
Storage
System
Information

zoom woE (=) (F TELE Speed [20 = Restore Al
Foous NEAR (=) (O FAR  Speed [20 =] | CAuto Focus Refresh

Figure 5-11

Step 2

Adjust the focal length of the lens.

After it is zoomed, set “Speed” and press “+”, “-“or drag the sliding block directly to adjust.

Step 3

Adjust the lens definition.

After it is focused, set “Speed” and press “+”, “-“or drag the sliding block directly to adjust.

Note:

® Speed is used to set the length by pressing “+” and “-“.

® After adjusting the focal length of the lens or click “Auto Focus”, the device will auto adjust the
image definition, it is not allowed to implement other lens operation during auto focus.

® After several times of zoom and focus, the image fails to be adjusted clear, click “Restore All’ to
reset the lens to zero and remove the accumulative error of the lens.

® Click “Refresh” and the device will automatically synchronize the hardware to the location of sliding
block of lens zoom and focus.

5.1.2 Video
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5.1.2.1 Video

Step 1

Select “Setup > Camera > Video > Video” and the system will display the interface of “Video” which is
shown in Figure 5-12 or Figure 5-13.

IP Camera

Video Snapshot Overlay

Main Stream Sub Stream
Enable Sub Stream 2 v
Encode Mode H.264H v Encode Mode H.264H v
Smart Codec OFF v * Resolution D1 (7047480) v
Resolution 2304x1296 (230471296 ¥ Video Clip
LTI Frame rale(FPS) |30 v Frame rate(FPS) |6 v
Bit Rate Type CBR v Bit Rate Type CBR M
Reference BitRate  1792-10240Kb/S Reference BitRate  48-806Kb/S
Bit Rate 6144 A Bit Rate 896 v
| Frame Interval 60 (30~150) | Frame Interval 12 (6~150)

Y

Watermark Settings

Watermark Character | Digital CCTV

Default H Refresh H Save

Figure 5-12 (Non fisheye)

IP camera

Video Snapshot

2 UG Installation Mode Ceiling
Record Mode 2P |z|
> Audio
Network Main Stream Sub Stream
Event Enable Sub Stream 1 E
Storage Code-Stream Type | General Code-Stream Type | General [=]
System S H 264 = Encode Mode H.264 [+]
Information St 20322432 (24322432 Resolution B40x640 (640°640) |~
Frame rate(FPS) 16 Frame rate(FP3) 15 E
Bit Rate Type CBR [=] SRR CBR [=]
Reference BitRate  2048-11008KbIS Reference BitRate  256-1792Kb/S
Bit Rate 8192 s 1024 [=]
| Frame Interval 30 (15~150) | Frame Interval _3[] (15~150)
sve 1(off) [=] Ve 1(off) [=]
[¥] Watermark Settings
Watermark Character | DigitalCCTV
Default ‘ | Refresh ‘ | Save

Figure 5-13 (Fisheye)
Step 2
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Set video bit stream, please refer to the following sheet for more details about the parameters.

Parameter

Function

Installation Mode

It will display the parameter when the device is fisheye.
There are three installation modes for fisheye which are
ceiling, wall mount and ground installation, please
select installation mode according to the actual
installation scene of the fisheye.

The system will begin to switch after switching
installation mode, it will prompt successfully saved after
it is switched successfully.

Note:

The device end will output the dewarped video stream
after configuring installation and record mode, when the
device is accessed to third-party platform, it will directly
display the dewarped image on the third-party platform.

Record Mode

It will display the parameter when the device is fisheye.

The system will begin to switch after record mode is

switched, it will prompt saved successfully after it is

switched successfully.

The record mode will change according to the different

installation modes.

® 10: the original picture which is not dewarped.

® 1P:360°rectangular panorama.

® 2P: The mode can be set when the “Installation
Mode” is set as “Ceiling” or “Ground”. It is the 2
related 180°rectangular image, the two
subwindows can both form 360°panorama anytime.

® 10+3R: original image + 3 independent sub
images, both the sub image and sub boxes in the
original image can support zoom and movement.

® 1R: Original image + independent sub image, the
sub boxes of the original image support zoom and
movement.

® 4R: original image + 4 independent sub images,
both the sub image and sub boxes in the original
image support zoom and movement.

® 2R: Original image + 2 independent sub images,
the sub boxes of the original image can support
zoom and movement, the sub image supports up
and down movement, which can change the
vertical angle of view.

Note:

The device end will output dewarped video stream after

configuring installation and record mode, when the

device is accessed to the third-party platform, it will

directly display the dewarped image on the third-party

platform.
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Parameter

Function

Sub Stream Enable

Select “Enable” to enable sub stream.
The device supports enabling sub stream 1 and sub
stream 2 at the same time.

Smart Codec

It can enhance image compression performance and
reduce storage space by enabling intelligent encoding.
Note:

After intelligent encoding is enabled, the device will not
support third stream, ROI or intelligent event detection,
please refer to the actual interface for more details.

Code-Stream Type

ACF means using different fps to record.

There are two options: VBR and CBR.

Please note you can set video quality in VBR mode.
Note:

WEB interfaces don’t support motion detect and alarm
code stream setting.

Encode mode

There are five options: H.264 (main profile standard,

H.264H (high profile standard), H.264B (Baseline

Profile), H.265 (main profile standard) and MJPEG

encode.

® The H.264, H.264H both are H264 bit stream.
H.264 is the Main Profile encode and you need to
enable the sub stream function in your camera and
set the resolution as CIF. Then you can monitor via
the Blackberry cell phone.

® The H.265 is the main profile encode mode.

® MJPEG: In this encode mode, the video needs to
large bit stream to guarantee the video definition.
You can use the max bit stream value in the
recommend bit to get the better video output effect.

Resolution

There are multiple resolutions. You can select from the
dropdown list.

For each resolution, the recommended bit stream value
is different.

Note: When video is under rotating status, you cannot
set resolution higher than 1080P (excluding 1080P).

Video Clip

The function is only supported by sub stream 2, please
refer to “Video Clip” for more details below the sheet.

Frame Rate (FPS)

PAL: 1~25f/s, 1-50f/s NTSC: 1~30f/s or 1~60f/s.
The frame rate may vary due to different resolutions.

Bit Rate Type

There are two options: VBR and CBR.
Please note, you can set video quality in VBR mode.
Under MUPEG mode, only CBR is available.

Recommended Bit

Recommended bit rate value according to the resolution
and frame rate you have set.
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Parameter

Function

Bit Rate

® In CBR, the bit rate here is the max value. In
dynamic video, system needs to low frame rate or
video quality to guarantee the value.

® The value is null in VBR mode.

® Please refer to recommend bit rate for the detailed
information.

SVC

Frame rate can be encoded by layer. It is a flexible
encoding method. By default, itis 1 as 1 layer. You also
can set 2/3/4 layers.

| Frame

Here you can set the P frame amount between two |
frames. The value ranges from 1 to 150. Default value
is 50.

Recommended value is frame rate *2.

Watermark Settings

Select “Watermark Setting” and enable watermark
function. After the watermark function is enabled, you
can check if the video is tampered via verifying
watermark character.

Watermark Character

It is the character of watermark verification, it is
Digital CCTV by default.

® Video Clip

1. Select “Sub Stream 2” in the drop-down box, click “Enable”.

2. Enable “Video Clip”, click " .

The system will display the interface of “Area”, which is shown in Figure 5-14.
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Resolution

DA (7047480)

[=]

Save

Zancel

Figure 5-14

Select the needed resolution and clip the needed image on the interface, which is shown in Figure

5-15.

Click “Save”. You can check the clipped video in the preview interface (the sub stream 2 preview
interface only displays the clipped area), which is shown in Figure 5-15.
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IP Camera

Step 3

Protacol E.

Figure 5-15

Click “Save” to complete video stream setup.

5.1.2.2 Snapshot

The snapshot interface is shown as in Figure 5-16.

IP Camera

Video
> Co 3

> Audio

Snapshot Type
Image Size
Quality
Network

Interval
Event

Storage

System

Snapshot
| General
1080P (192071080)
E
15

| Default | I Refresh ‘ |

Figure 5-16

Please refer to the following sheet for detailed information.
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Parameter Function

Snapshot type There are two modes: general (schedule) and Event (activation).
Image size It is the same as the resolution of main stream.

Quality It is to set the image quality. There are six levels.

Interval It is to set snapshot frequency. Optional1~7s/picture, customized.

5.1.2.3 Video Overlay

The video overlay interface is shown as in Figure 5-17.

IP Camera

> Conditions
> Audio
Network

Event

Storage
System

Information

Snapshot

! () Enable @ Disable
»+ Channel Title
+ Time Title
----- + Text Overlay
» Picture Overlay

» Counting

W&mw& All

Delete | (Or Rightelick )

‘ Defauit

Refresh H Save ‘

Figure 5-17
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IP camera

> Conditions

> Audio
Network

Event
Storage
System

Information

» Privacy Masking @ Enable ) Disable
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» Time Title IPC

» Text Overlay

» Picture Overlay

» Counting

IP Camera
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[ vieeo |
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Network

Event

Storage

System

Information

Snapshot
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Save

Path
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Figure 5-19
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IP Camera

> Audio
Network
Event
Storage
System

Information

» Privacy Masking
+ Channel Title

» Time Title

» Text Overlay

» Picture Qverlay
» Counting

() Enable © Disable

Input Text:

Text Align
Right

IP Camera

> Conditions
» Audio
Network
Event
Storage
System

Information

» Privacy Masking
+ Channel Title

» Time Title

» Text Overlay

+ Counting

©) Enable @ Disable

Picture Preview:

Uplead Picture

Requirement for picture upload
1. Max size is 16k

2. Max resolution is 128x128 pixels.
3. 256 colors, bmp format.

Figure 5-21
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IP Camera

> Conditions

> Audio

Network B
Event

Storage

System

Information

Snapshot

: » Privacy Masking ) Enable @ Disable
» Channel Title Statistics Type
|+ Time Tite Enter Number

B o Leave Number

» Picture Overlay = TextAlign

| o 2

Figure 5-22
Please refer to the following sheet for detailed information.
Parameter Function
Privacy Masking ® Here you can privacy mask the specified video in the
monitor video.
® System max supports 4 privacy mask zones.
Time Title ® You can enable this function so that system overlays time
information in video window.
® You can use the mouse to drag the time tile position.
Channel Title ® You can enable this function so that system overlays
channel information in video window.
® You can use the mouse to drag the channel tile position.
Text Overlay ® You can enable this function to overlay text in video

window.
® You can use the mouse to drag location box to adjust its
position. Alignment include align left and align right.

Picture Overlay

® You can enable this function to display overlay picture.
Click on disable to turn it off.

® Click on Upload Picture to overlay local picture into
monitoring window. You can drag the yellow box to move
it.

Note:

You cannot enable text and picture overlay at the same time.

Counting

® Check “Enable” to display the counting statistics data in
the video monitoring window; check “Disable” not to
display.

® There are enter number and leave number for statistics
type and left align and right align for OSD info.
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Refresh ® Set privacy mask, channel title, time title, location, overlay
and save the change. You can click on Refresh to see

effect.
Default ® Click it to restore default config.
Save ® (Click it to complete video settings.

5.1.2.4 ROI
Note: Some series don’t support ROl setup function.

IP camera AP, - e ST SN G-

Snapshot

overlay

Enable ' Disable

| Image Quality Gibest) v

Storage
System
Information

| Remove Al H Delete ‘(OrR\gm:Hck)

| Default H Refresh H Save

Figure 5-23

IP camera

c Snapshot Overlay

> Conditi
> Audio
Network

Enable #) Disable

Image Quality | G(best) v

Event
Storage
System
Information

Remave All Delete (Or Rightclick )

| Default H Refresh H Save
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Figure 5-24

Parameters | Note

Enable Check “Enable”, then it will display the ROI in the video monitoring window;
Check “Disable”, then it won’t display.
e Set the image quality of ROI, ranging from 1~6, default is 6.

Image Note:

Quality For fisheye device, it ranges from 1~6 (best), default is 6 (best)
e Able to set area block, max 4 areas.

5.1.2.5 Path

The storage path interface is shown as in Figure 5-25.

Here you can set snap image saved path and the record storage path.

® The default monitor image path is C:\Users\admin\WebDownload\LiveSnapshot.

® The default monitor record path is C:\Users\admin\WebDownload\LiveRecord.

® The default playback snapshot path is C:\Users\admin\WebDownload\PlaybackSnapshot.
The default playback download path is C:\Users\admin\WebDownload\PlaybackRecord.

The default playback cut path is: C:\Users\admin\WebDownload\VideoClips.

Note:

Admin is locally logged in PC account.

Please click the Save button to save current setup.

IP Camera

Video

Snapshot

S
2 Live Snapshot C:\Users\admin'WebDownload\LiveSnapshot
~ Video
Live Record C:\Users\admin\WebDownload\LiveRecord
> Audio
Playback Snapshot  C:\Users\admin\WebDownload\PlaybackSnapshot
Network
E " Playback Download | C:\Users\admin\WebDownload\PlaybackRecord
ven
Video Clips C:\Users\admin'WebDownload\VideoClips
Storage
System Default | ‘ Save
Information

Figure 5-25
5.1.3 Audio
Please note some series devices do not support audio function.
5.1.3.1 Audio

The audio interface is shown as below. See Figure 5-26.
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IP camera

Audio
> Conditions

> Video [ Encode

~ Audio Main Stream
Network [¥] Enable
Event Encode Mode G.711A [+]
Storage Sampling Frequency | 16k |Z|
System
. Sub Stream
Information
[ Enable Sub Stream 1 [=]
Encode Mode G.711A |z|
Sampling Frequency | 16k [+]
— Aftribute —
Audioln Type Lineln
Moise Filter Enable [~
Microphone Volume [=] D 50

Speaker Yolume

= 0 (E3k]

Default H

Refresh ‘ | Save ‘

Figure 5-26
Please refer to the following sheet for detailed information.
Parameter Function
Enable You can enable audio only when video is enabled.

After selecting the “Enable” of main stream or sub stream, the
network transmission stream is the audio/video composite
stream, otherwise it only includes video image.

Encode mode

The encode mode of the main stream and extra stream include
G.711A, G.711Mu, G.726 and ACC. The default mode is
G.711A.

The setup here is for audio encode mode and the bidirectional
talk encode both.

Sampling
Frequency

The sampling frequency of audio. It includes the following
options:

® 38K

® 16K
® 32K
® 48K
® 64K
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Audioln Type Two modes to select: Lineln, Mic. Device needs to connect
external audio input source under Lineln mode, and it doesn’t
need to connect external audio input source under Mic mode.

Noise Filter Enable the function and it can filter relevant noise.
Microphone Adjust microphone volume from 0~100.
Volume Note:

Supported by some devices.

Speaker Volume | aqi,ct speaker volume from 0~100.

Note:
Supported by some devices.

5.1.3.2 Alarm audio

IP Camera

Alarm Audio

> Video

Network

i« alarm1.pcm 0
el alarm2 pem o

Event
Storage
System
Information

Figure 5-27
Add Audia File [ 2|
i~ Record i Upload
Audio File | pcm
Recard
Figure 5-28

Audio management currently supports PCM format to record and PCM, wav two forms to upload,
and can select an audio file for the audio alarm linkage.
The way to download the web alarm playback audio file into local is as follows:
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Step 1 Use the left mouse button to click the hollow circle " in the “choice” column on the left,

and shows = , which means effective choice of alarm audio.

Step 2 Use the right mouse button to click : , select “save target as” to download.

5.2 Network

5.2.1 TCP/IP

The TCP/IP interface is shown as in Figure 5-29. It supports IPv4 and IPv6. IPv4 supports static IP and
DHCP. IPv6 supports static IP only. When users manually modify IP address, WEB will automatically
jump to the new IP address.

IP Camera

Camera TCPIP
Network

» Connection Ethemet Card Wire(DEFAULT)
> PPPoE Mode © Static © DHCP

Host Name IPC

> DONS MAC Address

> Bonjour

> IPFiter IP Version IPv4
& SRS L) IP Address 10 .15 . 1 . 171
> UPnP Subnet mask 255 255 0 .
> SNMP
Default Gateway 10 15 o .
5 .

Preferred DNS Server| 8 8
> Muliicast

_ Altemate DNS Server | 8§ 8 4
> 802.1x

> QoS Enable ARP/Ping to set IP address service

Event Defaut || Refiesh || saw
Storage

System

Information

Figure 5-29
Please refer to the following sheet for detailed information.
Parameter Function
Host Name It is to set current host device name. It max supports 15
characters.
Ethernet Card Please select the Ethernet port. Default is wired.

Please note you can modify the default Ethernet card if there is
more than one card.

Mode There are two modes: static mode and the DHCP mode. Select
DHCP mode, it auto searches IP, and you cannot set IP/subnet
mask/gateway. Select static mode, you must manually set
IP/subnet mask/gateway.

Mac Address It is to display hose Mac address.
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IP Version It is to select IP version. IPV4 or IPV6.
You can access the |IP address of these two versions.
IP Address Please use the keyboard to input the corresponding number to

modify the IP address and then set the corresponding subnet
mask and the default gateway.

Preferred DNS

DNS IP address.

Alternate DNS

Alternate DNS IP address.

Enable
ARP/Ping set
device IP
address service.

You can use ARP/Ping command to modify or set the device IP
address if you know the device MAC address.

Before the operation, please make sure the network camera
and the PC in the same LAN. This function is on by default.

You can refer to the steps listed below.

Step 1: Get an IP address. Set the network camera and the PC
in the same LAN.

Step 2: Get the physical address from the label of the network
camera.

Step 3: Go to the Run interface and then input the following
commands.

arp —s <IP Address> <MAC>

ping —| 480 —t <IP Address>

Such as: arp -s 192.168.0.125 11-40-8c-18-10-11
ping -I 480 -t 192.168.0.125

Step 4: Reboot the device.

Step 5: You can see the setup is OK if you can see there are
output information such as “Reply from 192.168.0.125 ...” from
the command output lines. Now you can close the command
line.

Step 6: Open the browse and then input http://<IP address>.
Click the Enter button, you can access now.

5.2.1.1 Easydip

Click “Enable” to connect the device to network, and then you can connect to the device via mobile

client of Easy4ip after “Online” is displayed on the interface (connection mode: add device serial number
or scan QR code). See Figure 5-30.
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IP camera

Easy4ip

Camera TCPIP

== [] Enable
> Connection Status Offline
> PPPoE
SM 1L0092EPAADDZTO
>
QR Code

> IP Filter
> SMTP(Email)

> UPnP

> SNMP

Default | ‘ Refresh | | Save

> Bonjour

Event
Storage
System

Information

Figure 5-30

5.2.2 Connection

5.2.2.1 Connection
The connection interface is shown as in Figure 5-31.

IP camera

Camera Connection

5 ’ Max Connection 10 (1~20)
> PPPoE UDP Port 37778 (1025~65534)
> DDNS HTTP Port 80
> IP Filter RTSP Part 554
> SMTP(Email) HTTPs Port 443
> UPnP
Default Refresh H Save

> SNMP | ‘

> Bonjour

> Mul

Event

Storage

System

Information

Figure 5-31

Please refer to the following sheet for detailed information.
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Parameter | Function

Max It is the max Web connection for the same device. The value ranges from 1
connection | to 20. Default connection amount is 10.

TCP port Port range is 1025~65534. The default value is 37777. You can input the
actual port number if necessary.

UDP port | Portrange is 1025~65534. The default value is 37778. You can input the
actual port number if necessary.

HTTP port | Port range is 1025~65524. The default value is 80. You can input the
actual port number if necessary.

RTSP port | ® The default value is 554. Please leave blank if use default. User uses
QuickTime or VLC can play the following formats. BlackBerry can play
too.

® Real-time monitoring URL format, please require real-time RTSP
media server, require channel no., bit stream type in URL. You may
need username and password.

® User uses BlackBerry need to set encode mode to H.264B, resolution
to CIF and turn off audio.

URL format is:
rtsp://username:password@ip:port/cam/realmonitor?channel=1&subtype=0
Username/password/IP and port.

The IP is device IP and the port default value is 554. You can leave it in
blank if it is the default value.

Follow standard RTP protocol and when encode mode is MJPEG, the max
resolution only supports 2040*2040.

HTTPs HTTPs communication port, range is 1025~65534, default is 443.
Port

Note:

® (0~1024, 37780~37880, 1900, 3800, 5000, 5050, 9999, 37776, 39999, 42323 are all special ports.
User cannot modify them.

® Avoid using default port value of other ports.

5.2.2.2 ONVIF

ONVIF (Open Network Video Interface Forum) , this standard describes network video mode,
interface, data type and data interaction mode. ONVIF Standard’s aim is to achieve a network video
frame agreement and makes the network video products (including video front-end, video equipment,
etc.) from different manufacturers completely compatible.

ONVIF function is on by default.
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IP camera

Connection

Authentication @ ON (O OFF

Default | ‘ Refresh ‘ | Save

> PPPoE
> DDNS
> IP Filter
> SMTP(Email)

Storage
System

Information

Figure 5-32

5.2.3 PPPoE

The PPPoE interface is shown as in Figure 5-33.

Enter the PPPoE username and password which are provided by ISP (Internet Service Provider), and
click “Enable”. The network camera will automatically establish network connection in the mode of
PPPoE after it is enabled, after it is successful, the IP of the “IP Address” will be automatically modified
into the dynamic IP address of the acquired WAN.

Note:

After PPPoE dial-up is successful, it needs to log in the device via the IP which is set before dial-up; in
the PPPoE setup interface, it will display the registered IP address, and then it can visit the IP address
via client.

Please disable UPnP when clicking PPPoE enable, which is to avoid causing influence to PPPoE dial-
up.

IP Camera

Camera PPPoE
Network
[C] Enable

> TCPIP
> Connection

Password
> DDNS
> IP Filter
> SMTP(Email)
» UPnP
> SNMP

Usemame

» Bonjour
> Multicast
> 802.1x
> QoS
Event

Storage

System

Information
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Figure 5-33
5.2.4 DDNS
The DDNS interface is shown as in Figure 5-34.
The DDNS is to set to connect the various servers so that you can access the system via the server.
Please go to the corresponding service website to apply a domain name and then access the system
via the domain. It works even your IP address has changed. When the device connects to WLAN, you
should disable UPnP.

IP Camera

Camera DDNS

™ Server Type QUICK DDNS =

Server Address www.quickddns.com

> TCPIP
> Connection

Hode = Aute © manual
> PPPOE

DONS | Domain Name 9002A91CCOCE quickddns.com

> IPFilter Username (Optional)Please inputthe mailbox

> SWTP(Email) Detaut || Retesn || sae

> UPnP

> SNMP
> Bonjour
> Multicast
> WIFI

> 8021
> QoS
Event
Storage

System

Information

Figure 5-34

Please refer to the following sheet for detailed information.

Parameter Function

Server Type Click it to select DDNS protocol type, which includes: CN99
DDNS, NO-IP DDNS, Dyndns DDNS, Quick DDNS, the default is
Quick DDNS.

Server Address | DDNS server IP address

CN99 DDNS

Server address: www.3322.0rg

NO-IP DDNS

Server address: dynupdate.no-ip.com

Dyndns DDNS

Server address: members.dyndns.org

Quick DDNS

Server address: www.quickddns.com

Mode Default is auto, it can select manual
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Parameter Function

Domain Name | Both auto and manual are “MAC addresss.quickddns.com” by
default, it is able to set prefix manually.

Username The user name you input to log in the server, optional.

The CN99 DDNS interface is shown as in Figure 5-35.

IP camera

Camera DDNS

Network [] Server Type CN39 DDNS [=]

> TCPIP
Server Address

> Connection
> PPPoE

> IP Filter
» SMTP(Email) Update Period 10 Minute (1~500)

Domain Name none
Usemame none

Password

> UPnP ‘ Refresh | | Save
> SNMP

> Bonjour
» Multicast
> 802.1x
> QoS

Event

Storage

System

Information

Figure 5-35

Parameter Function

Server Type You can select CN99 DDNS protocol

Server Address | Under CN99 DDNS, the default server address is “www. 3322. org”.

Domain Name Self-defined domain name

Username The user name you input to log in the server.

Password The password you input to log in the server

Refresh Period

is 10 minutes.

The refresh period of the connection between the device IP and the server, default

5.2.5 IP filter
The IP filter interface is shown as in Figure 5-36.

You can enable IP filter function so that some specified IP/MAC user can access the network camera.

You can add IP address or IP segment.
If you do not check the box here, it means there is on access limit.
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Here you can add IP address and MAC address. You must add these addresses before enabling the

trusted sites.

Please note: You must set MAC address in the same network segment.

IP Camera

Camera

> TCPAP

> Connection

> PPPoE

> DDNS
.

> SMTP(Email)

> UPnP

> SNMP

> Bonjour

» Multicast

> 802.1x

> QoS
Event

Storage

System

Information

IP Filter

Trusted Sites

Trusted Sites
IP address /MAC address Modify Delete
i
[ Defat || Refesh || Save

5.2.6 SMTP (e-mail)
The SMTP interface is shown as in Figure 5-37.

IP camera

Camera

> TCPIP

> Connection

> PPPoE

> DDNS

> IP Filter
SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

Event

Storage

System

Information

SMTP(Email)

SMTP Server
Port

[C] Anonymity
Usemame
Password

Sender

Authentication
Title

Mail Receiver

Interval

[”] Health Mail

Figure 5-36

none

25
anonymity
ssee
none
None [=]
IPC Message Attachment
+
0 Second (0~3600)
Update Period Second (1~3600)
[ Defaur || Refiesh || sae

Figure 5-37

Please refer to the following sheet for detailed information.
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Parameter

Function

SMTP Server

Input server address and then enable this function.

Port

Default value is 25. You can modify it if necessary.

Anonymity For the server which supports the anonymity email function, it
won’t display the information of the sender.

User Name The user name of the sender email account.

Password The password of sender email account.

Sender Sender email address.

Authentication You can select SSL, TLS or none.

(Encryption

mode)

Title (Subject) Input email subject here.

System can send out the email of the snapshot picture once

Attachment
you check the box here.

Mail receiver Input receiver email address here. Max three addresses.

Interval The send interval ranges from 0 to 3600 seconds. 0 means
there is no interval.
Please note system will not send out the email immediately
when the alarm occurs. When the alarm, motion detection or
the abnormity event activates the email, system sends out the
email according to the interval you specified here. This
function is very useful when there are too many emails
activated by the abnormity events, which may result in heavy
load for the email server.

Health mail Please check the box here to enable this function.

enable

Email test The system will automatically sent out a email once to test the
connection is OK or not .Before the email test, please save
the email setup information.

5.2.7 UPnP

It allows you to establish the mapping relationship between the LAN and the public network.

Here you can also add, modify or remove UPnP item. For UPnP on different routers, you must disable
UPnP function. See Figure 5-38.

In the Windows OS, From Start->Control Panel->Add or remove programs. Click the “Add/Remove
Windows Components” and then select the “Network Services” from the Windows Components Wizard.
Click the Details button and then check the “Internet Gateway Device Discovery and Control client” and
“UPnP User Interface”. Please click OK to begin installation.
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Enable UPnP from the Web. If your UPnP is enabled in the Windows OS, the network camera can auto
detect it via the “My Network Places”.

Under manual mode, you can modify external port. Under auto mode, select idle port for auto port
mapping without user modification.

IP Camera

Camera UPnP

[C] Enable Mode Manual E| Router State Mapping Failed
Port Mapping List

> TCPAP
> Connection

Service Name Protocol Internal Port External Port Status Modify
> PPPoE WebService WebService: TCP 80 8080 Mapping Failed £ =
> DDNS PrivService PrivService:TCP 37T 3rriv Mapping Failed
> IP Filter PrivService PrivService:UDP 37778 37778 Mapping Failed
> SMTP(Emai) RTSPService RTSPService:TCP 554 554 Mapping Failed

» SNMP
> Bonjour

> Muilticast

» 802 1x

> QoS

Event

Storage

System

Information

Figure 5-38

5.2.8 SNMP

The SNMP interface is shown as in Figure 5-39 and Figure 5-40.

The SNMP allows the communication between the network management work station software and the
proxy of the managed device. Please install the software such as MG MibBrowser 8.0c software or

establish the SNMP service before you use this function. You need to reboot the device to activate the
new setup.
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IP camera

Camera SNMP
S SNMP Version
> TCPIP

> Connection SNMP Port

» PPPoE Read Community
> DDNS Write Community

> IP Filter Trap Address
> SMTP(Emai)

> UPnP

SNMP

> Bonjour

Trap Port

> Multicast
> 802.1x
> QoS
Event

Storage

System

Information

[7] SNMPv1 [7] SNMP w2 [T] SNMP v3

181 (1~65535)
public

private

162

Figure 5-39
Please refer to the following sheet for detailed information.
Parameter Function
SNMP Version ® Check SNMP v1, device only process v1 info.
® Check SNMP v2, device only process v2 info.
® Check SNMP v3, can set username, password and
encryption method. Server calibrate corresponding
username, password and encryption method too access
device and v1/v2 are unavailable.
SNMP port The listening port of the proxy program of the device. It is a
UDP port not a TCP port. The value ranges from 1 to 65535.
The default value is 161
Community It is a string, as command between management and proxy, ,

defining a proxy, and a manager’s authentication.

Read community

Read-only access to all SNMP targets, default is public.
Note: Only number, letter, _, and — supported.

Write community

Read/write access to all SNMP targets, default is private.
Note: Only number, letter, _, and — supported.

Trap address

The destination address of the Trap information from the
proxy program of the device.

Trap SNMP trap is a proxy message sent to admin as important
event notice or status change.

Trap Address Address where to send Trap message.

Trap Port Port which send Trap message, default is 162, range

1~65535.
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IP camera

Camera
N
> TCPIP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
» UPnP

> Bonjour

> Multicast
> 802.1x

> QoS
Event
Storage

System

Information

Check SNMP v3 version and SNMP port, read community, write community, Trap address, Trap port

SNMP

SNMP Version

SNMP Port

Read Community
Write Community
Trap Address

Trap Port

Read-only Usemame
Authentication Type
Authentication Password
Encryption Type

Encryption Password

Read&write Username
Authentication Type
Authentication Password
Encryption Type
Encryption Password

SNMP w1

161

public

private

162

public

@ MD5 © SHA
@ CBC-DES
private

@ MD5 (O SHA

@ CBC-DES

SNMP v2 SNMP v3

(1~65535)

Default ‘ ‘

Figure 5-40

are same with SNMP v1 and SNMP v2 versions. Only when SNMP version is SNMP v3, users need to
configure parameter in chart.

Parameter Function

SNMP Version | SNMP v3

Read-only Rg{:ylt is public.

Usermame Name only can be number, letter and underline.
Read/Write Rg{:ylt is private.

Usermame Name only can be number, letter and underline.
Authentication | You may select MD5 or SHA, default is MD5.
Authentication Password not less than 8 characters.

Password

Encryption Default is CBC-DES.

Encryption

Password Password not less than 8 characters.
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5.2.9 Bonjour

The Bonjour interface is shown as below. See Figure 5-41.

Bonjour is based on the multicast DNS service from the Apple. The Bonjour device can automatically
broadcast its service information and listen to the service information from other device.

You can use the browse of the Bonjour service in the same LAN to search the network camera device
and then access if you do not know the network camera information such as IP address.

You can view the server name when the network camera is detected by the Bonjour. Please note the
safari browse support this function. Click the “Display All Bookmarks: and open the Bonjour, system can
auto detect the network camera of the Bonjour function in the LAN.

IP camera

Camera Bonjour
Network

Enable
> TCPIP

Server Name YZCAEZODBW00012

> Connection
> PPPoE Default
> DDNS
> IP Filter
> SMTP(Email)
> UPnP
> SNMP

Bonjour
> Muliicast
> 802.1x
> QoS
Event
Storage

System

Information

Figure 5-41

5.2.10 Multicast

The multicast interface is shown as in Figure 5-42.

Multicast is a transmission mode of data packet. When there is multiple-host to receive the same data

packet, multiple-cast is the best option to reduce the broad width and the CPU load. The source host

can just send out one data to transit. This function also depends on the relationship of the group

member and group of the outer.

Note:

® Open preview, streaming media protocol, select multicast, and monitor via multicast format.

® Here you can set multicast address and port. You also need to go to Live interface to set the
protocol as Multicast.
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IP Camera

Network

> TCPfP

Main Stream

Camera Multicast

Sub Stream

Enable Enable Sub Stream 1 [~]
> Connection :
Multicast Address 224 1 2 . 4 |(224.000~239255255255) Multicast Address 224 . 1 2 4 | (224.0.0.0~239.255.255 255)
> PPPoE
Port 40000 (1025~65534) Port 40002 (1025~65534)

> DDNS
> IP Filter
> SMTP(Email)
» UPnP
> SNMP
> Bonjour
| haieast___|
» 802.1x
> QoS

Event

Storage

System

Information

Defak || Refesh || sae

Figure 5-42

Please refer to the following sheet for detailed information.

Parameter

Function

Enable

Select to enable multicast function. Main stream and sub stream cannot be
used at the same time.

Multicast address

Main/sub stream multicast default address is 224.1.2.4 and its range is
224.0.0.0~239.255.255.255.

Port

Multicast port. Main stream is 40000, sub stream1 is 40016,sub stream2 is
40032 and the range is 1025~65534.

5.2.114G

Note: This function is only for series with 4G module.

4G is a mobile communication system which makes wireless communication integrates with Internet

and multimedia communication.

5.2.11.1 Dialing Setting
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IP Camera

Camera

> IP Filter

> SMTP(Email)
> UPnP

¥ Bonjour

> Multicas

Storage

System

Information

Dialing Setting | Mobile Settings

Wireless Net Type Auto |Z| [¥] Enable

APN 3gnet

Authorize Mode No |z|

Dial-up Number 9%

Usemame

Password

Update Period 30 Second

Time Range

Wireless Network State

IP Address

Wireless Signal WCDMA 0%
FDD-LTE . 70 %

Detaut || Reesn || saw
Figure 4-53
Parameter Function

Wireless Net Type

Auto, WCDMA, FDD-LTE optional, you can select according
to the operator.

Enable

Check to enable 4G module.

APN

It shall be acquired from the operator according to the setup
of operator.

Authentication Mode

Auto, PAP and CHAP, the authentication algorithm is
different according to different operators.

Dial-up Number

The number is different according to different operator, it can
be acquired from operator.

User name

It shall be acquired from the operator.

Password

It shall be acquired from the operator.

Update Period

It is the period beyond the dial-up period which has been
set, it is 30s by default, which means the device can auto
acquire 4G dial-up status, cut off dial-up to save flow.

Time Range It is the time period to set dial-up. It can activate the function
via message to enable/disable dial-up function if it is
beyond the time period.

IP Address It will display the acquired IP after the dial-up is successful

via 4G.
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5.2.11.2 Mobile Setting

IP camera

Camera Dialing Sefting | Mobile Settings

[7] Message Send [7] Message Activation [7] Phone Activation

Receiver + Sender +| Caller

> IP Filter
> SMTP(Email)
> UPnP

> Bonjour

Title Ewvent Message

Storage

System ‘ ‘

e oration Default Refresh | | Save
Figure 4-54
Please refer to the following sheet for detailed information.
Parameter Function
Message Send In the event, after the corresponding message activation is

enabled, it will send message to the phone of receiver when
event happens. It needs to enable the function of message
activation function in the event interface when using the

function.
Message It can send message ON/OFF to the SIM card inside the device by
Activation the mobile phone in the list, which is to enable /disable the dial-up

function and send REBOOT to restart the device.

Phone Activation You can use the mobile phone in the calling list to call the SIM card
inside the device to enable dial-up function.

5.2.12 WIFI

Note:

Some series devices don’'t support WIFI and WPS function.
WPS function is supported by the devices with WPS button.

5.2.12.1 WIFI
WIFI info can show the name, status, IP information of the Current Hot Spot. Usually please “Refresh”
WIFI work information after reconnection to ensure the real-time display of the work status, because it
often takes some time to connect WIFI Hot Spot, which depends on the network signal strength.
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IP camera

Camera WIFI

™ Enable ‘ Add SSID || Search 551D |

> TCPAP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

WIFI INFO
% Current Hot Spot
> QoS IP address
Event Subnetmask
Storage Default Gateway

System

Information

Figure 5-45

WIFI| setting method is as follows:

Step 1

V¥ Enable
Click M= , show as , means enabling WIFI function.

Step 2

Click “ Search SSID”, and shows the wireless network hot spot of the current network camera
environment in the list.

IP camera

Camera WIFI

¥ Enable Add S5ID || Search 581D |

> TCPIP

> Connection
> PPPOE 12345 WPA-PSK-AES
> DDNS 5370test WPAMWPAZ-PSK-TKIP+AES
> IP Filter
TP-LINK_485EF6 WPA-PSK-TKIP+AES
> SMTP(Email)
AndroidAP WPAS-PSK-AES
> UPnP
TP-LINK_425795 WPAMWPA2-P SK-TKIP+AES
> SNMP
) NETGEARG4 MONE
> Bonjour

> Multicast TP-LINK_NIIAN WPANWPA2-PSK-TKIP+AES

WIFIINFO

CurrentHot Spot  unconnected
> QoS IP address

Event Subnetmask

Default Gateway

Storage

System

Information

Figure 5-46



Step 3

Click “Add SSID” when need to add a wireless network manually, pop out an interface in the figure

below, and enter network ID in the dialog box.

Add Wireless SSID [ X |

331D

Ok Cancel

Figure 5-47

Step 4 Double click on one can pop out the signal intensity and authentication of the hot spot.

+ Please enter the password if necessary. Please keep the choice of password index

number same as the router when entering password.

» Please click “connect” if it is unnecessary to enter the password.

5.2.12.2 WPS

IP camera

Camera WIFI

 Enter PIN
>

PIN:

> Connection

851D

> PPPOE

.

> DDNS Button

> IP Filter Status disconnected

> SMTP(Email) Connecting ‘ | Refresh

> UPnP

> SNMP

> Bonjour
> Multicast
> 80Z2.1x
> QoS
Event
Storage

System

Information

Figure 5-48

PIN Number and SSID are both acquired from the router, please “refresh” the work information of WIFI

to ensure the real-time display of work state after filling in correctly.

5.2.13802.1x
802.1x (port based network access control protocol) supports manual selection of authentication

method to control if device connected to LAN can join the LAN. It well supports authentication, charging,

safety and management requirement of network.



IP camera

Camera 802.1x
Network

> TCPIP

> Connection

> PPPoE

» DDNS

» IP Filter

> SMTP(Email)

» UPnP

> SNMP

[C] Enable
Authentication
Usemams

Password

> Bonjour
> Multicast
> QoS
Event
Storage

System

Information

Figure 5-49

Please refer to the following sheet for detailed information.

Parameter Function

Authentication | PEAP (protected EAP protocol).

Username It needs the username to login, which is authenticated by the
server.
Password Please input password here.
5.2.14 QoS

The QoS interface is shown as below. See Figure 5-50.

Qos (Quality of Service) is network security mechanism. It is a technology to fix the network delay and
jam problem and etc. For the network service, the quality of service includes the transmission bandwidth,
delay, the packet loss and etc. We can guarantee the transmission bandwidth, lower the delay, and
reduce the loss of the data packet and anti-dither to enhance the quality.

We can set the DSCP (Differentiated Services Code Point) of the IP to distinguish the data packet so
that the router or the hub can provide different services for various data packets. It can select the
different queues according to the priority (64 different priority levels) of the packets and select the
bandwidth of the each queue. Level 0 is the lowest, and level 63 is the highest. It can also discard at the
different ratio when the broad bandwidth is jam.
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IP camera

Camera QoS
Realtime Monitor

> TCPIP

> Connection

> PPPoE

> DDNS

> IP Filter

> SMTP(Email)

» UPnP

> SNMP

Command

> Bonjour
> Multicast
» 802.1x
[ cos
Event
Storage
System

Information

Figure 5-50
Please refer to the following sheet for detailed information.
Parameter Function
Real-time The value ranges from 0 to 63. The router or the switcher can
monitor provide different service for various data packets.
Command The value ranges from 0 to 63. The router or the switcher can
provide different service for various data packets.
Enable Check it to enable QoS.
Wireless QoS
5.2.15HTTPs

In the HTTPs setting interface, users can make PC log in normally via HTTPs by creating certificate or

uploading signed certificate, which is to guarantee the security of communication data and provide

safeguard for user information and device security with reliable and stable technical means.

Step 1

Create certificate or upload the signed certificate.

® Please refer to the following steps if you select “Create Certificate”.

1. Select “Setup > Network > HTTPs”, and the system will display the interface of HTTPs, which is
shown in Figure 5-51.
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IP Camera

Camera

s TCPIP [T] Enable HTTPs

> Connection Create Certificate
ZR Request Created

> IP Filter

Request Created

> SMTP(Email)

Install Signed Certificate
> UPnP

Certificate Path
Certificate Key Path

Certificate Installed

| ‘ ‘ | Download

Browse

Browse.

Ceriificate Installed I:l
Aftribute
Event
Storage Refresh ‘ ‘ Save
System
Information
Figure 5-51
2. Click “Create” and it will pop out the dialog box of “HTTPs”, which is shown in Figure 5-52.
HTTPs LS
Country CM *e.g. CN
IP or Domain name | 10.15.15.211| *
Validity Period 365 Day*Range :1-5000
Province none
Location none
Organization none
Crganization Unit none
Email
Creat Cancel
Figure 5-52

3. Fill'in corresponding “Country”, “Province” and some other information, click “Create” after filling in.

It will show the prompt of “Create Successfully”, which means the server certificate has been

successfully created.
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Note:
Make sure the “IP or domain name” is the same as that of the device.
4. Click “Install” and it will install the certificate on the device end, which is shown in Figure 5-53.

IP Camera

Camera

5 TC [T] Enable HTTPs
> Connection Create Certificate
BREE Request Created
> IP Filter

Request Created HiIP= 5.15211.C ST=none:L=non = - Delete ‘ | | ‘ Download
> SMTP(Email)

Install Signed Certificate

> UPnP
> SNMP Certificate Path
> Bonjour Certificate Key Path , | " |
> Multicasi Certificate Installed

Certificate Installed P=10.15.15.211;C=C T=none;L= O=none

Attribute Issue to: HIP=10.15.15.211; C=CN; ST=none; it

L=none; O=none; OU=none; EM=; =

Event Issuer: HIP=test, C=CN, ST=test, L=test, O=test, -
Storage Refresh ‘ ‘ Save
System
Information

Figure 5-53
5. Click “Download”. It will pop out the dialog box of “Save as”, save the file into the computer.
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Organize * B v @

B Desktop
j Downloads
“El Recent Places

Libraries
Open a library to see your files and arrange them by folder,...

Documents
| 4 Libraries | Library
[ Documents
[+ Jl Music & Music
I [ Pictures "'-q.,‘/ LAty
i B Videos

@ Pictures
— g Library
48 Computer
> & Local Disk (C:) Videos
[ =5 DISK1_VOLZ (Dx) g Library

b =y DISKI_VOL3 (E}) -
File name: RootCert.cer =
Save as type: [ ("cer) =
|~ Hide Folders o save | [ Cancel ]

Figure 5-54
Double click the downloaded icon of “RootCert.cer”. The system will display the information
interface of “Certificate”, which is shown in Figure 5-55.
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Certificate ﬂ

General | Details I Certification Path

@ﬁ Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to:  test

Issued by: test

Valid from 2015/ 7/ 8 to 2020/ 7/ 7

[I.ns13|| Certificate. J Issuer Statement

Figure 5-55
7. Click “Install Certificate” and it will pop out the interface of “Certificate Import Wizard”, which is
shown in Figure 5-56.
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Certificate Import Wizard &

Welcome to the Certificate Import

Wizard
i This wizard helps you copy certificates, certificate trust
;_‘ / lists, and certificate revocation lists from your disk to a

- tificate store.
= ']’ certificate store
A certificate, which is issued by a certification authority, is

a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. & certificate store is the system area where
certificates are kept.

To continue, dick Next.

ik MNext > ][ Cancel ]

s ]
[+
m

Figure 5-56

8. Click “Next”. Select “Trusted Root Certification Authorities”, which is shown in Figure 5-57.
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Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can spedfy a location for
the certificate.

(") Automatically select the certificate store based on the type of certificate
i@ Place all certificates in the following store

Certificate store:

Trusted Root Certification Autharities i Browse. .. i

Learn mare about cerfificate stores

<Back | Mext> | | cancel

Figure 5-57
9. Click “Next”. The system will display the interface of “Completing the Certificate Import Wizard”,
which is shown in Figure 5-58.
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Completing the Certificate Import
Wizard

The certificate will be imported after you dick Finish.

You have spedified the following settings:

Certificate Store Selected by User [EgVHr=s L=0od o= gl
Content Certificate
4 1 E

<Back | Finsh | [ cancel

Figure 5-58

10. Click “Finish”, and it will pop out the dialog box of “Security Warning”, which is shown in Figure 5-59.
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Security Warning |g

You are about to install a certificate from a certification authority (CA)
claiming to represent:

test

Windows cannot validate that the certificate is actually from "test”. You
should confirm its crigin by contacting "test”. The following number
will assist you in this process:

Thumbprint (shal): 8DE11FD2 EB2313A8 663514ED 2CA3GELE TD425FAG
Warning:

If you install this root certificate, Windows will automatically trust any
certificate issued by this CA. Installing a certificate with an unconfirmed
thumbprint is a security risk. If you click "Yes" you acknowledge this

risk.

Do you want to install this certificate?

Yes Mo

Figure 5-59
11. Click “Yes”. It will pop out the dialog box of “Import Successful”, click “Ok” to complete downloading
certificate, which is shown in Figure 5-60.

Certificate Import Wizard ﬁ

| The import was successful.

Figure 5-60
® Please refer to the following steps if you select “Install Signed Certificate”.
1. Select “Setup > Network > HTTPs”. The system will display the interface of HTTPs, which is shown
in Figure 5-61.
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IP Camera

Camera

> [T] Enable HTTPs

> Connection Create Certificate
> DDNS Request Created
> IP Filter
Request Created g | | I5ia | | Download
> SMTP(Email)
Install Signed Certificate
> UPnP
> SNMP Ceriificate Path C erCe Browse
> Bonjour Certificate KeyPath  C < key.p Browse | Upload |
Certificate Installed
Certificate Installed

Aftribute

Storage Refresh ‘ ‘ Save

System

Information

Figure 5-61
2. Select signed certificate and certificate key path respectively via “Browse”, click “Upload”.
3. Install root certificate, please refer to step 6~11 for more details.
4. Check “Enable HTTPs”, click “Save”. The system will display the dialog box of “Need to reboot the
device”, and then the config is valid.

Reboot

ﬁ The configuration takes effect, the device is restarting now, please dontleave this page or close the browser...

Figure 5-62
5. Use HTTPs
Use HTTPs to log in.
Enter https://xx.xx.xx.xX in the browser, and it will pop out normal login interface; the browser will prompt
certificate error if the certificate is not installed, which is shown in Figure 5-63.
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'!' (¥ @] http=//101515.211/

File Edit View Favorites Tools Help

7 Favorites | s B B v g FEETE -

I /& Certificate Error: Navigation Blocked | |

e
|.@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
server.

We recommend that you close this webpage and do not continue to this website.
& Click here to dose this webpage.

'@' Continue to this website (not recommended).

@ More information

Figure 5-63
Note:
“XX.XX.XX.Xx" is corresponding to your IP or domain name.

5.3 Event

5.3.1 Video detection

5.3.1.1 Motion Detection

Step 1

Select “Setup > Event > Video Detection > Motion Detection’ and the system will display the interface of
“Motion Detection” which is shown in Figure 5-64.
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IP Camera

Camera Motion Detection] Video Tampering
Network

Scene Changing

cvent [C] Enable
~ Video Detection
- o Working Period
> Audio Detection
Anti-Dither 5 Second (0~100)
> Face Detection Record
> People Counting Record Delay 10 | Second (10~300)
> Heat Map e
2 tlamn S 10 Second (10~300)
> Abnormality
"] Send Email
Storage
[7] snapshot
System
Information Default H Refresh H Save

Figure 5-64

Step 2

Select “Enable” to enable motion detection function.
Step 3
Set motion detection area.

1. Click “Setup” and the system will pop out the interface of “Setting Area”, which is shown in Figure 5-

65

86



Region | H =

Name }Region‘l |

Sensitivity [ s— |—(E] 60
Threshold (=) {}—(F) 5

Reve Al ‘ ‘ Delete ‘ (Or Rightelick )

‘_. Save | ‘ Cancel |

Figure 5-65

2. Set area name, it is to set valid area of motion detection according to the actual situation, and it can
set the value of sensitivity and threshold respectively.
The bigger the sensitivity is, the easier it is to generate motion detection, the smaller the threshold is,
the easier it is to generate motion detection; the entire video image is the valid area of motion
detection by default.

Note:

® Different colors represent different areas; each area can set different detection area.

® The red line in the Oscillogram means triggering motion detection; green line means not triggering

motion detection.

3. Click “Save” to complete area setting.

Step 4

It is to set other parameters of motion detection, please refer to the following sheet for more detalils.
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Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from Os to 100s.

Area

1. Click “Setup” and the system will pop out the interface of “Set Area”.

2. Setthe area name, it is to set the valid area of motion detection
according to the actual situation, and it can set its sensitivity and
threshold respectively. The higher the sensitivity is, the easier it is to
trigger motion detect, the smaller the area threshold is, the easier it is
to generate motion detect, the whole video image is the valid area of
the motion detect by default.

Note:

Different colors represent different areas; each area can set different

detection areas.

The red line in the Oscillogram means triggering motion detect, the green

line means not triggering motion detect.

3. Click “Save” to complete area setup.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Audio linkage Check it and the system will play alarm audio file when alarm occurs. Us¢

can set the recorded or uploaded audio file in “camera setting > audio >
alarm audio”.
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Parameter Function

Flash linkage Check it and the flash will be on when alarm occurs, and the flash will
be off until the end of alarm after corresponding delay.

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to

preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

Snapshot You need to check the box here so that system can backup motion detectior
snapshot file. You shall set snapshot period in Storage>Schedule.

Step 5

Click “Save” to complete the setting of motion detection.

5.3.1.2 Video Tampering

Step 1

Select “Setup > Event > Video Detection > Video Tampering” and the system will display the interface of
“Video Tampering” which is shown in Figure 5-66.

IP Camera

Camera
Network

_ Video Detection

Motion Detection Jvideo Tamperingl Scene Changing

[] Enable Video Tampering
Working Period

[¥] Record

Record Delay 10
[¥] Relay-out

Alarm Delay 10
[C] sendEmail

[7] Snapshot

["] Enable Defocus Detection

Second (10~300)

Second (10~300)

Storage

Default

|| Refresh H Save

system

Information

Figure 5-66
Step 2
Set the parameter of video tampering; please refer to the following sheet for more details.
Parameter Function
Enable video You need to check the box to enable video mask detection alarm.
tampering

Enable defocus
detection

You need to check the box to enable defocus detection alarm.
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Parameter Function

Working Period | Note: L .
It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Record Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Audio linkage Check it and the system will play alarm audio file when alarm occurs. Usé¢
can set the recorded or uploaded audio file in “camera setting > audio >
alarm audio”.

Flash linkage Check it and the flash will be on when alarm occurs, and the flash will
be off until the end of alarm after corresponding delay.

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to

preset x when there is an alarm.
® The event type includes: preset, tour and pattern.
Snapshot You need to check the box here so that system can backup motion detectior
snapshot file. You shall set snapshot period in Storage>Schedule.

Step 3
Click “Save” to complete the setup of video tampering.

5.3.1.3 Scene Changing

Step 1

Select “Setup > Event > Video Detection > Scene Changing” and the system will display the interface of
“Scene Changing” which is shown in Figure 5-67.
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Camera Motion Detection || Video Tampering
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Video Detection .

> Audio Detection

> Alarm

> Abnormality

[T] Enable

‘Working Period

[¥] Record

Record Delay 10 Second (10~300)
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[C] Snapshot
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Storage

Default H Refresh H save

System

Information

Step 2

Figure 5-67

Check “Enable” to enable the function of scene changing.

Step 3

It is to set the parameters of scene changing, please refer to the following sheet for more details.

Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when

alarm occurs and ends. User can set email address in Network>SMTP.
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Parameter Function
PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.
® The event type includes: preset, tour and pattern.
Snapshot You need to check the box here so that system can backup motion detectior
snapshot file. You shall set snapshot period in Storage>Schedule.
Step 4

Click “Save” to complete the setup of scene changing.

5.3.2 Audio Detection

Step 1

Select “Setup > Event > Audio Detection” and the system will display the interface of “Audio Detection”
which is shown in Figure 5-68.

IP Camera

Camera

Audio Detection

[C] Enable Input Abnormal
["] Enable Intensity Change
Sensitivity = D 50
Threshold =) 0 50
> Abnormality
Storage
Working Period m
IEke ot Anti-Dither 5 Second (0~100)
[¥] Record
Record Delay 10 Second (10~300)
[¥] Relay-out
Alarm Delay 10 Second (10~300)
[[] Send Email
[F] Snapshot
| Default ‘ | Refrash ‘ | Save

Step 2

Figure 5-68

It is to set the parameters of audio detect, please refer to the following sheet for more details.

Parameter Function
Enable input Select “Enable Input Abnormal” and it will trigger alarm when it detects
abnormal audio input abnormity.

Enable intensity
change

Select “Enable Intensity Change” and it will trigger alarm when it detects
that audio intensity change exceeds the threshold.
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Parameter

Function

Sensitivity It can be judged as audio abnormity when the input volume change
exceeds continuous environment volume; users need to adjust according
to the actual environment test.

Threshold It is to set the filtered environment volume intensity, if the environmental

noise is too big, then the value needs to be set higher, users can adjust
according to the actual environment test.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Anti-dither System only memorizes one event during the anti-dither period. The value
ranges from Os to 100s.
Record Check it and so when alarm occurs, system will auto record. You shall set

record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to

preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

Snapshot You need to check the box here so that system can backup motion detectior
snapshot file. You shall set snapshot period in Storage>Schedule.

Step 3

Click “Save” to complete the setup of audio detection.



5.3.3 Smart Plan

Smart plan is the master switch for intelligent analysis such as “Face Detection”, “Heat Map”, “IVS”,
“People Counting” and so on, the corresponding intelligent functions can be valid after smart plan is
enabled.

Step 1

Select “Setup > Event > Smart Plan”. The system will display the interface of “Smart Plan”, which is
shown in Figure 5-69.

IP camera

Camera Smart Plan
Network

Storage

System

Information

Figure 5-69
Step 2
Click “Save” to complete the config of smart plan.

5.3.4 Intelligence Behavior Analytics
The basic requirements of scene selection
® The total proportion of the target shall not exceed 10% of the image.

® The target size in the image can’t be less than 10 pixel x10 pixel, the size of abandoned target can’t

be less than 15 pixel x 15 pixel (CIF image); The height and width of the target can’'t exceed 1/3 of
the image; it is recommended that the target height is about 10% of the image height.

® The difference of brightness value between target and background can’t be less than 10 gray levels.

® Make sure the target appears at least over 2 seconds continuously in the field; the movement
distance has to be bigger than the width of the target itself and makes sure it is no less than 15
pixels (CIF image).

® Try to lower the complexity of the monitoring scene analysis if it is possible; it is not advised to use
IVS functions in the environment where the targets are dense and light change is very frequent.

® Tryto keep away from the areas such as glass, ground reflected light, water surface, branch,

shadow, mosquito disturbance and etc.; try to keep away from the backlight scene to avoid direct
light.
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5.3.41 IVS
5.3.4.1.1 Tripwire

It will trigger alarm when the target crosses the warning line according to the movement direction which

has been set.

It needs some time from when the target appears to when the target is confirmed, so it has to leave
some space on both sides of the warning line when setting the warning line, please do not set the
warning line near the obstructions.

Application scene: it can be applied to the scene with sparse target and there is barely any blocks
between the targets, such as the unmanned perimeter defense.

Step 1

Select “Setup > Event > IVS > IVS” and the system will display the interface of “IVS”.

Step 2

Click to set rule name and select the rule type as “Tripwire” which is shown in Figure 5-70.
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Figure 5-70
Step 3
Click “Draw Rule” to draw tripwire in the monitoring scene, click the right mouse button to complete
tripwire setting.
Step 4
Click “Draw Target” to draw the size model of filtered target in the video image.
Step 5
It is to set the parameters of tripwire, please refer to the following sheet for more details.
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Parameter

Function

Object tracking

Select “Object tracking” to enable the function, refer to “2.4 Video Window
Adjustment” for more details.

Note:
The function is only supported by some models.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Direction

It is to set the direction of tripwire, you can select A->B. B->A. A<->B.

Object Track

Select “Object Track” and it will enable the function of object track; when the
moving object triggers rule and generates alarm, it will select the display
mode of object track such as 1P+3 or 1P+5 in the preview interface, the
scene of tracking window will follow the moving object till the object leaves
the view range of the camera. Please refer to “2.4.8 Fisheye/Trigger Track”
for more details.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click “Save” to complete the setup of tripwire.

5.3.4.2 Intrusion

Intrusion includes cross and appears.




® Cross means that it will trigger alarm when the target enters or exits the area.

Appears means that it will trigger alarm when the target appears in the area.

® As for the report interval of the IVS function in the area, the system will trigger an alarm if it detects
same event happened during the interval; the alarm counter will become zero if there is no same
event happened in the interval.

It needs to leave some space for target movement for the area periphery if it is to detect enter & exit

event, which is similar to the warning line.

Application scene; it can be applied to the scene where the target is sparse and there is barely any

obstruction between the targets, such as the unmanned perimeter defense.

Step 1

Select “Setup > Event > IVS > IVS” and the system will display the interface of “IVS”.

Step 2

Click to set rule name, select the rule type as “Intrusion” which is shown in Figure 5-71.
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Figure 5-71

Step 3

Click “Draw Rule” to draw an area in the monitoring image.

Step 4

Click “Draw Target” to draw the size model of filtered target in the video image.
Step 5

It is to set the parameters of intrusion, please refer the following sheet for more details.
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Parameter

Function

Object tracking

Select “Object tracking” to enable the function, refer to “2.4 Video Window
Adjustment” for more details.

Note:
The function is only supported by some models.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Action

It is to set the action of intrusion, you can select appears and cross.

Direction

It is to set the direction of intrusion, you can select enter, exit and
enter&exit.

Object Track

Select “Object Track” and it will enable the function of object track; when the
moving object triggers rule and generates alarm, it will select the display
mode of object track such as 1P+3 or 1P+5 in the preview interface, the
scene of tracking window will follow the moving object till the object leaves
the view range of the camera. Please refer to “2.4.8 Fisheye/Trigger Track”
for more details.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can sgnd out err_lail to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click “Save” to complete the setup of intrusion.



5.3.4.3 Abandoned Object

Abandoned object means the system will trigger alarm if the abandoned object in the monitoring scene
exceeds the time which has been set by the users.

Abandoned object and missing object can be confusing in a situation where both foreground and
background are complicated.

It also triggers alarm as abandoned object if there is pedestrian or vehicle staying still for too long. In
order to filter this kind of alarm, generally the abandoned object is smaller than people and vehicle;
therefore it can filter the people and vehicle via setting size. Besides, it can avoid the false alarm caused
by short stay of people via extending alarm time properly.

Application scene: It can be applied to the scene where the target is sparse and there is no obvious and
frequent light change. False alarm will be increased in the scene with high target density and frequent
blocking; false alarm will be increased in the scene where there are more people staying. As for the
detection area, try to make it simple, the function is not suitable for the area which is too complicated.
Step 1

Select “Setup > Event > IVS > IVS” and the system will display the interface of “IVS”.

Step 2

Click to set rule name, select the rule type as “Abandoned Object” which is shown in Figure 5-72.

IP camera
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LSS No.  Rule Mame Rule Type L
@ 1 Ruest Abandoned Ob[+] @ *
~ Parameter Setup
e ‘Working Per\o:!
> HeatMap | b | S
£ o Bl BREE | KeepTime |10 | Second (5~3600)
> Abnarmality '—- LT RS ‘ —
Storage T[T — [7] Record .
system i e Record Delay | 10 | second (10~300)
Information [ Relay-out
Alarm Delay .WU_ | Second (10~300)
TargetFilter @ MaxSize &191 * 81¢ [l send Email
@ Min Size & 0 Clear SR
‘ Default | | Refresh ‘ ‘ Save
Figure 5-72
Step 3
Click “Draw Rule” to draw an area in the monitoring area.
Step 4
Click “Draw Target” to draw the size model of filtered target in the video image.
Step 5
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It is to set the parameter of abandoned object, please refer to the following sheet for more details.

Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Keep time It is to set the shortest time from when the object is abandoned to when it
triggers alarm.
Record Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click “Save” to complete the setup of abandoned object.

5.3.4.4 Missing Object
Missing object means the system will trigger alarm if it exceeds certain amount of time after the target is
taken away from the original scene.

The system can make statistics of the still areas in the foreground area and distinguish if it is missing
object or abandoned object according to the similarity between foreground and background, it will
trigger alarm when it exceeds the time which is set by users.

Because the system distinguishes abandoned object from missing object according to the similarity of
foreground and background, it may cause error between abandoned object and missing object in a
situation where both foreground and background are complicated.
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Application scene: it can be applied to the scene where the target is sparse and there is no obvious and
frequent light change. False alarm will be increased in the scene where the target density is high and
there is frequent obstruction; the false alarm will be increased in the scene where there are more people
staying. As for the detection area, try to make it simple, the function is not suitable for the area which is

too complicated.

Step 1

Select “Setup > Event > IVS > IVS” and the system will display the interface of “IVS”.

Step 2

Click to set rule name and select rule type as “Missing Object”, which is shown in Figure 5-73.

IP Camera

Camera
Network

> Video Detection

> HeatMap
> Alarm

> Abnormality
Storage
System

Information

Step 3

No.  Rule Name Rule Type dn
1 Rulel Missing Object[~] T~
- Parameter Setup
Working Period
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RecordDelay | 10 Second (10~300)
[7] Relay-out
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Target Filter @ Max Size Draw Target [] send Email
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Click “Draw Rule” to draw an area in the monitoring scene.

Step 4

Click “Draw Target” to draw the size model of filtered target in the video image.

Step 5

It is to set the parameters of missing object, please refer to the following sheet for more details.

101



Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Keep time It is to set the shortest time from when the object is missing to when it
triggers alarm.
Record Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click “Save” to complete the setup of missing object.

5.3.5 Face Detection

Step 1

Select “Setup > Event > Face Detection” and the system will display the interface of “Face Detection”,
which is shown in Figure 5-74.
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Figure 5-74
Step 2
Select “Enable” to enable face detection function.
Step 3
Click “Draw Target” to draw the size model of target filter in the video image.
Step 4
It is to set the parameters of face detection, please refer to the following sheet for more details.
Parameter Function
Note:

Working Period

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Enable Face Select “Enable Face Enhancement” and it will guarantee that the face is
Enhancement clear by priority when the stream is set very low.
Record Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.
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Parameter Function

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click “Save” to complete the setup of face detection.

5.3.6 People Counting
5.3.6.1 People Counting
Step 1

Select “Setup > Event > People Counting > People Counting” and the system will display the interface
of “Entrance/Exit”, which is shown in Figure 5-75.
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Step 2

Figure 5-75

Select “Enable” to enable statistics function of entrance and exit.

Step 3

Click “Draw Rule” to draw an area in the monitoring image.

Step 4
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Click “Draw Target” to draw the size model of filtered target in the video image.
Step 5
It is to set the parameters of entrance and exit, please refer to the following sheet for more details.

Parameter

Function

Enable OSD

Select “Enable OSD” and it will display the people number statistics of
entrance and exit in the monitoring image.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.
1. Click “Setup” and the system will pop out the interface of “Working

Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).
3. Click “Save” to complete the setup of working period.

It is to select wall mount if there is an angle between device lens and

Installation _ I . :
Mode horizontal surface, select ceiling if the device lens face downward vertically.
Rule Name Itis to set the name of rule.

Direction It is to select the direction of entrance and exit statistics; A->B or B->A, the

arrow direction always means the entrance direction.

Flowrate Alarm

It is to set the enter number, leave number, stranded number; it will trigger
alarm when it exceeds the limited number.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 6

Click “Save” to complete the setup of people counting.

5.3.6.2 Report
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It is to generate a form of report according to the number statistics.

Step 1

Select “Setup > Event > People Counting > Report “and the system will display the interface of “Report’,
which is shown in Figure 5-76.
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==
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People Counting.
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Storage

System

Information

Figure 5-76
Step 2
It is to set search condition, please refer to the following sheet for more details.
Parameter Note
Report Type Can select day report, month report and year report; also can select bar chart or line
P yp chart to display the report.
Time It can set the begin /end time within the range of statistics time.

It can select enter, leave and display number; the data of checked item can be

Flow Direction displayed in the report.

Search Search flow statistics data according to the setting to form report.
Export Export the saved report.
Step 3

Click “Search” to complete report statistics, click “Export” to export the report.

5.3.7 Heat Map

5.3.7.1 Heat Map

It is the density statistics of moving object that can generate report, the color range is from blue to red,
blue means the min heat value and red means the max heat value.

Mirroring, view angle change and heat map original data will be cleared.

Step 1
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Select “Setup > Event > Heat Map > Heat Map” and the system will display the interface of “Heat Map”,
which is shown in Figure 5-77.

IP Camera

Camera

Network Enable

Working Period

Storage

System

Information

Default | | Refresh | | Save

Figure 5-77
Step 2
Select “Enable” to enable heat map function.
Step 3
It is to set the working period.
1. Click “Setup” and the system will display the interface of “Working Period”, which is shown in Figure
5-78.
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Figure 5-78

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to drag on the setup interface to
set.

® There are six periods to be set every day, select the check box in front of the period, and then the
period is valid.

® Select week number (it selects Sunday by default, if it selects the whole week, then it means the
setup can be applied to the whole week, you can also select the check box in front of the week
number to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Step 4
Click “Save” to complete the setup of heat map.

5.3.7.2 Report

It is to generate the form of report according to the heat map data.

Step 1

Select “Setup > Event > Heat Map > Report” and the system will display the interface of “Report”, which
is shown in Figure 5-79.
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Figure 5-79

Step 2

It is to set begin time and end time.

Step 3

Click “Search” to complete report statistics, click “Export” to export the statistics report.

5.3.8 Alarm
Please note some series products do not support this function.

5.3.2.1 PIR alarm

The alarm activation interface PIR alarm is shown as in figure 5-80.
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Figure 5-80
Please refer to the following sheet for detailed information.
Parameter Function
Enable After enabled, relay activation will work. Check it and enable the
PIR alarm.
Working ® This function becomes activated in the specified periods.
period ® There are six periods in one day. Please draw a circle to
enable corresponding period.
® Select date. If you do not select, current setup applies to
today only. You can select all week column to apply to the
whole week.
® Click OK button, system goes back to motion detection
interface; please click save button to exit.
Note: User can set via dragging mouse while not releasing left
mouse.
Anti-dither System only memorizes one event during the anti-dither period.
The value ranges from Os to 100s.
Flash After enabling, the system will automatically turn on the flash
when alarm occurs.
Flash Delay e The flash will be off with a period of time delay when the
alarm linkage is over.
e Time is calculated by unit of second and ranges from
10s~300s.
Record System auto activates motion detection channel to record once

alarm occurs (working with motion detection function).

Record Delay

System can delay the record for specified time after alarm ended.
The value ranges from 10s to 300s.
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Parameter Function

Relay out Enable alarm activation function. You need to select alarm output

port so that system can activate corresponding alarm device when
alarm occurs.

Alarm delay System can delay the alarm output for specified time after alarm

ended. The value ranges from 10s to 300s.

Send Email After this function is enabled, system can send out email to alert

you when alarm occurs and ends.

Audio Linkage | Check it and the system will play alarm audio file when alarm

occurs. Users can set recorded audio file in “Camera Setting >
Audio >Alarm Audio”.

Snapsh

ot After you enabled snapshot, the system will automatically
snapshot if alarm occurs.

5.3.8.1 Alarm Linkage

IP Camera
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> Audio Detect
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Relay-in Alarm1 i
Working Period

> IVS Analyse Anti-Dither 0 Second (0~100) SensorType [MO -
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2 ey ¥ Record
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2RIl ¥ Relay-out
Soas Alarm Delay 10 Second (10~300)
Sysem ™ Send Email
Information
™ Audio Linkage
I~ Snapshot
Default | | Refresh | | Save
Figure 5-81
Parameter Function
Enable Check it and enable the alarm linkage.
Relay-in The default alarm 1, some products can choose alarm 2.
Two types of sensor which are normally open (NO) and normally closed (NC),
Sensor Type switch from normally open to normally closed, open the alarm. Switch from normally
closed to normally open, shut the alarm.
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Parameter Function

Check it and set PTZ movement when alarm occurs. Such as go to preset x when
PTZ there is an alarm.

The event type includes: preset, tour and pattern and so on.

5.3.8.2 Flash Set

IP camera [ uve [ Paymsck [ sewp | mam [ Logout |

Camera
Network

PIR Alarm Relay Activation Flash Set Audio Detect

m Weak (=) U Strong

» Video Detect = A1 ¥ Sunday ™ Monday  Tuesday W wednesday W Thursday W Friday ¥ Saturday

> Audio Detect I¥ Period 1: 00 : 00 : 00 23 : 589 : 59

> IVS Analyse | Default ‘ | Refresh | | Save

> Face Detect

> People Counting
> Heat Map

> Abnormality
Storage
System

Information

Figure 5-82
Parameter Function
ON/OFF ON means flash is on; OFF means flash is off.
Weak-strong Via dragging this bar to adjust flash brightness.
bar
All Check and it means the day flash works.
Period Period that flash is on.

5.3.8.3 Audio detection

Note: Audio detection won’t work when “Talk” is enabled on the preview interface.
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Figure 5-83
parameter Function
Enable Check it and enable audio detection.
Threshold Itﬂ:\r/glsar(l)?ger alarm and set up a series of linkage when volume exceeds the set

5.3.9 Abnormity

Abnormity includes No SD Card, Capacity Warning, SD Card Error, Disconnection, IP Conflict and
Unauthorized Access.

Note:

Only device with SD card function has these three statuses: No SD card, capacity warning, and SD card
error. Device without SD card function does not have the above three statuses. See Figure 5-84 to
Figure 5-86.
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Figure 5-84
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Figure 5-85
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Figure 5-86

Please refer to the following sheet for detailed information.

Parameter | Function

Enable Check to alarm when SD card is abnormal.

Relay-out Check to enable relay-out alarm.

Relay out | The alarm output can delay for the specified time after alarm stops. The
delay value ranges from 10s to 300s.

Note:

No SD card, capacity warning, SD card error, relay-out delay all start
from alarm occurs.

Send After you enabled this function, the system can send out email to alarm
email the specified user.

This function is invalid when network is offline or IP conflict occurs.

SD Card User can set SD card capacity that is left free. When SD card space left
Capacity | is smaller than this limit, alarm occurs.
Limit

When device is offline or IP conflicts, the abnormal alarm is similar with case of SD card error.
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Figure 5-87

When login password keep been wrong for a few times, unauthorized access alarm occurs. This
operation is similar to SD card error. Allow login error times as when it exceeds this limit, user account
will be locked.
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Figure 5-88

5.4 Storage Management

5.4.1 Schedule

Before schedule setup, user must set record mode is auto or manual.

Note:

If record mode in record control is off, then device will not snapshot according to schedule.
5.4.1.1 Record Schedule

Record schedule steps:

Step 1. Click on Record Schedule, see Figure 5-89.
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Camera Record Schedule
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Figure 5-89

Step 2. From Monday to Sunday select record time, click on setup on the right, see Figure 5-90.
® Set period according to actual need. There are six periods available each day.
® By checking or unchecking, you can add or delete three types of record schedule: General, Motion,

and Alarm.
Note:
Period setup can be done by dragging in record schedule interface while not releasing left mouse.
Setup X |
T Al ¥ sunday T Monday I Tuesday I Wednesday I Thursday [ Friday [ Saturday [ Holiday
Period 1: 00 : 00 : 00 |-| 23 : 59 : 59 | [C Genmeral M motion I Alarm
Period 2; 00 - 00 : 00 |-| 23 : 59 : 59 | [[ceneral [~ motion [~ Alarm
Period 3: 00 : 00 : 00 |-| 23 : 59 : 59 | [ cenmeral [ motion I Alarm
Period 4: 00 ;00 00 |-| 23 : 59 : 59 | I General [ motion I Alarm
Period 5: 00 : 00 : 00 |-| 23 : 89 : 59 | [T ceneral I~ Motion [~ Alarm
Period & 00 ;00 00 |-| 23 : 59 : 59 | I General [ motion I Alarm
‘ Save | | Cancel |
Figure 5-90

Step 3. Click on OK, return to record schedule interface. See Figure 5-91.
® Green color stands for the general record/snapshot.

® Yellow color stands for the motion detect record/snapshot.

® Red color stands for the alarm record/snapshot.
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Figure 5-91

Step 4. In record schedule interface, click on OK. System prompts it is successfully saved.

5.4.1.2 Snapshot Schedule
Snapshot setup as:
Step 1. Click on Snapshot Schedule tab, see Figure 5-92.
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> Destination
> Record Control
System

Information

Figure 5-92

Step 2. From Monday to Sunday select snapshot time, click on setup on the right. See Figure 5-93.
® Set snapshot period according to actual need. There are six periods available each day.
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® By checking or unchecking, user can add or delete three types of snapshot schedule: General,
Motion and Alarm.

Note: Period setup can be done by dragging in snapshot schedule interface while not releasing left

mouse.

Setup (%]
A ¥ sunday I~ Monday I Tuesday I~ Wednesday I~ Thursday [~ Friday [ Saturday [ Holiday
Period 1: 00 : 00 : 00 |- 23 : 589 : 59 | [T General [ Wotion I Alarm
Period 2: 00 : 00 : 00 |-| 23 : 59 : 59 | [ General [ motion I Alarm
Period 3: 00 - 00 : 00 |- 23 . 59 : 59 | [ Gemeral [ motion I Alarm
Period 4: 00 : 00 : 00 |- 23 : 589 : 589 | [ Genmeral [ Motion I Alarm
Period 5: 00 : 00 : 00 |- 23 : 59 : 59 | [T Genmeral [ Motion I Alarm
Period B: 00 : 00 : 00 |-| 23 : 59 : 59 | [ General [ wmotion I Alarm
‘ Save ‘ | Cancel ‘
Figure 5-93

Step 3. Click on OK, return to snapshot schedule interface. See Figure 5-94.
® Green color stands for the general record/snapshot.

® Yellow color stands for the motion detect record/snapshot.

® Red color stands for the alarm record/snapshot.
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Figure 5-94

Step 5. In snapshot interface, click on OK. System prompts it is successfully saved.
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5.4.1.3 Holiday Schedule

Holiday schedule can set specific date as holiday.
Step 1. Click on Holiday Schedule tab, see Figure 5-95.
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Figure 5-95

Step 2. Select date to set as holiday. The selected date will be highlighted in yellow.

Step 3. Check Record/Snapshot, click on Save. System prompts it is successfully saved.

Step 4. Check Record Schedule/Snapshot Schedule interface, click on setup next to Holiday, and refer
to setup of Monday to Sunday.

Step 5. Complete setup of holiday, then it records/snapshots according to date in holiday schedule.

5.4.2 Destination
5.4.2.1 Path

The destination interface is shown as in Figure 5-96.

Path can config record and snapshot storage path. There are three options: Local, FTP and NAS. You
can only select one mode. System can save according to the event types. It is corresponding to the
three modes (general/motion/alarm) in the Schedule interface. Please check the box to enable the save

functions.

Note: Only device supports SD card has local.
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IP camera

Camera

Path

e Record Snapshot
Event Event Type Scheduled Motion Detect Alarm Event Type Scheduled Motion Detect Alarm
Local Local
> Schedule TP ] [&] B FTP ] s a
> NAS [ O I NAS [ 0 |
> Record Control p— ‘ ‘ e ‘ ‘ p—
System
Information
Figure 5-96
Please refer to the following sheet for detailed information.
Parameter | Function
Event It includes: scheduled, motion detect and alarm.
Type
Local It saved in the SD card.
FTP It saved in the FTP server.
NAS It saved in NAS disk.
5.4.2.2 Local

The local interface is shown as in Figure 5-97.

Here you can view local Micro SD card or NAS disk information. You can also operate the read-only,
write-only, hot swap and format operation.

IP Camera

Camera

PEtioLk Attribute Used CapacityTotal Capacity

Read & Wiile f— | 6131.4MI7578.1M

Status
MNormal

Event Disk1

> Record Control

System

Information

ReadOnly || Resaawrme || Hotswap Refresh

Figure 5-97

5.4.2.3 FTP
The FTP interface is shown as in Figure 5-96.

121



You need to check the box to enable the FTP function. When network disconnect occurred or there is
malfunction. Emergency storage can save the record/snapshot picture to the local SD card. Click the
test button to check if the FTP server can be connected for test.

IP Camera

Camera Path
Network

Enable

Server Address
s Port 2 (0~65535)

> Schedule

User Name anonymity

Password

Remote Directory share

Information Emergency (Local)

Figure 5-98

5.4.2.4 NAS

You need to check the box to enable the NAS function. Select NAS storage, fill in NAS server address
and corresponding store path, then you can store video file or pictorial information in the NAS server.
See Figure 5-99.

IP camera

Camera Path
RStk Enable
Event

Server Address

Remote Directory
> Schedule

> Record Control

System

Information

Figure 5-99

Parameter Function

Server Address | Set IP address of NAS server.

Remote Set storage directory, videos and pictures can be stored in to corresponding server
Directory directory.

5.4.3 Record control
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The record control interface is shown as in Figure 5-100.

IP Camera

Camera
Network
Event

Disk Full
> Schedule

> Destination

Record Control

System

Information

Record Control

Pack Duration

Pre-event Record

Record Mode

Record Stream

8 Minute (1~120)

5 Second (0~5)

Overwrite [~]
@ Auto @) Manual O Off
Main Stream E‘
peraut || mewesn [ saw

Figure 5-100
Please refer to the following sheet for detailed information.
Parameter | Function
Pack Here you can select file size within 1Tmin~120min. Default setup is 8
Duration minutes.
Pre-record | Please input pre-record value here.
For example, system can record the four seconds video in the buffer.
The record begins from the fifth second.
Note:
Configure pre-record time, when alarm or motion detection occurs, if
there is no record, system will record the preceding n seconds
record.
Disk Full There are two options: stop recording or overwrite the previous files
when HDD is full.
® Stop: Current working HDD is overwriting or current HDD s full,
it will stop record.
® Overwrite: Current working HDD is full; it will overwrite the
previous file.
Record There are three modes: Auto/manual/close.
mode
Record There are two options: main stream and sub stream.
stream
5.5 System
5.5.1 General

The General interface is shown as in Figure 5-101.
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IP Camera

Camera General
Network

Event
Language
Storage

TVOut

> Auto Maintain

> Upgrade

Information

Device Name

Video Standard

Date&Time

| vzC4DZ021W00009

English El
PAL [~]
Open El

Default ‘ | Refresh | ‘ Save

Figure 5-101
Please refer to the following sheet for detailed information.
Parameter | Function
Device Itis to set device name.
Name Note: Different devices have different names.
Video This is to display video standard such as PAL.
Standard
Language You can select the language from the dropdown list.
TV Out You can open or close the function, it can only be supported by the
devices with TV Out.
® |Intelligent function will be disabled when TV Out is opened.
® [t will auto close TV Out when intelligent function is enabled.
® Some devices support SDI and HDCVI.

The date and time interface is shown as in Figure 5-102.
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IP Camera

Camera
Network

General Date&Time

Date Format Year-Month-Day E
Event Time Format 24-Hour-based System
Storage
Time Zone GMT+08 00 [=]
CurrentTime 2015 - 03 - 2 | 10 00 : 08
[”] DSTEnable
DST Type @ Date ) Week
> Default Start Time Jan =] [=] o0 - 00
> ImporExport End Time Jan 2 00 - 00
> Auto Maintain [] Synchronize with NTP
> Upgrade NTP Server clock.isc.org
Information Port 123
Update Period 10 Minute (0~20)
Default H Refresh || Save

Figure 5-102

Please refer to the following sheet for detailed information.

Parameter

Function

Date format

Here you can select date format from the dropdown list.

Time There are two options: 24-H and 12-H.

Format

Time zone | The time zone of the device.

Current It is to set system time. It becomes valid after you set.

Time

Sync PC You can click this button to save the system time as your PC current
time.

DST Enable | Here you can set both begin and end time of daylight saving time.

You can set according to the date format or the week format.

Synchronize

You can check the box to enable NTP function.

with NTP

NTP server | You can set the time server address.

Port It is to set the time server port.

Update It is to set the sync periods between the device and the time server.
period
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5.5.2 Account

® For user name and user group, the max length is 31 characters, which can be made up of digit,
letter, underline, hyphen, dot and @.

® Password can be 0~32 characters in number and letter only. User can modify other user’s

password.

User and group can be manually added to 18 and 8 respectively.

® User management adopts group/user modes. The user name and the group name shall be unique.
One user shall be included in only one group.

® Currently logged in user cannot change his/her own right.

5.5.2.1 Username
In this interface you can enable anonymity login, add/remove user and modify user name. See Figure 5-
103.

IP camera

Camera Account

Netwerk
[] Anonymous Login

Event
User Name Group

No. User Name ‘Group Name Remark Modify Delete
1 admin admin admin s account # =

> PTZ Settings
> Default

> Import/Export
> Auto Maintain

> Upgrade

Information Authority List

Live Playback Record Control Backup PTZ Account
Alarm Log Search Clear Log Upgrade Auto Maintain General
VideolAudio Schedule/Destination Metwork Abnormality Video Detect PTZ Settings
Defaultimpor/Export Conditions s

Add User

Figure 5-103

Enable anonymity login: Enable anonymity login, and input IP. No username or password is required,
you can log in by anonymity (with limited rights). You can click logout to end your session.

Add user: It is to add a name to group and set the user rights. See Figure 5-104.

Hidden user “default” is for system interior use only and cannot be deleted. When there is no login user,
hidden user “default” automatically login. You can set some rights such as monitor for this user so that
you can view some channel view without login.

Here you can input the user name and password and then select one group for current user.

Please note the user rights shall not exceed the group right setup.

For convenient setup, please make sure the general user has the lower rights setup than the admin.
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Add User X |

ser Mame
Fassword

Caonfirm Passwaord

Eroup IHII|I'|'|iI'| j
Femark
Authority List WAl
W Live i’
¥ Playback
¥ Record control
¥ Backup =l
Save Cancel
Figure 5-104
Modify user
It is to modify the user property, belonging group, password and rights. See Figure 5-105.
Modify password

It is to modify the user password. You need to input the old password and then input the new password
twice to confirm the new setup. Please click the OK button to save.

Please note, the password ranges from 0-digit to 32-digit. It shall include the number and letter only. For
the user who has the account rights, he can modify the password of other users.
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Meodify User Ed

Lser Mlame |admin j
™ Modify Password

Group |a:lmin j

Remark admin 's account

Authority List M Al

I Live i’

¥ Playback
¥ Record contral

¥ Backup =

Save Cancel

Figure 5-105

5.5.2.2 Group
The group management interface can add/remove group, modify group password and etc.
The interface is shown as in Figure 5-106.

IP Camera

Camera Account

Network
[7] Anonymous Login

Event
User Name Group

Storage

Group Name

1 admin administrator group
2 user user group
> P1Z
> Default
> Upgrade
Information Authority List
Live Playback Record Control Backup PTZ Account
Alarm Log Search ClearLog Upgrade Auto Maintain General
Video/Audio Schedule/Destination Network Abnormality Video Detect PTZ Settings
DefaultimportExport Conditions Vs
Add Group

Add group: It is to add group and set its corresponding rights. See Figure 5-107.
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Please input the group name and then check the box to select the corresponding rights. It includes:

preview, playback, record control, PTZ control and etc.

Add Group
Group
Femark
Authority List Al
I Live
I Playback
™ Record control
™ Backup
Save Cancel
Figure 5-107

Modify group

Click the modify group button, you can see an interface is shown as in Figure 5-108.

Here you can modify group information such as remarks and rights.

Modify Group

Group IHII|I'|'|iI'| j

Remark administrator group

Authority List IV Al
¥ Live ﬂ
¥ Playback
M Record contral
¥ Backup -]

Save Cancel
Figure 5-108

5.5.3 PTZ
Please note only some series products support this function.
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The PTZ settings interface is shown as in Figure 5-91.
IP Camera

Camera PTZ Settings

Hethork Protocol

Address
Baudrate
Data Bit
Stop Bit
> Default

> Import/Export

> Auto Maintain

> Upgrade

Information

FPELCOD
1

9600

3

1

EETETEDE]

None

Default ‘ | Refresh ‘ | Save

Figure 5-109
Please refer to the following sheet for detailed information.
Parameter | Function
Protocol Select the corresponding dome protocol.
Address Set corresponding dome address. Default value is 1.
Please note your setup here shall comply with your dome address;
otherwise you cannot control the speed dome.
Baud Select the dome baud rate. Default setup is 9600.
Rate
Data Bit Default setup is 8.
Stop bit Default setup is 1.
Parity Default setup is none.
5.5.4 Default

The default setup interface is shown as in Figure 5-110.
Please note system cannot restore some information such as network IP address, account and so on.
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IP Camera

Camera Default
Network

Event Default

Storage

> Auto Maintain

» Upgrade

Information

Figure 5-110

5.5.5 Import/Export
The interface is shown as in Figure 5-111.
IP Camera

Camera Import/Export

Hetwork Backup Path

Event

Import H

Storage

> Upgrade

Informaticn

Figure 5-111

Please refer to the following sheet for detailed information.

Parameter | Function

Import It is to import the local setup files to the system.

Export It is to export the corresponding system setup to your local PC.

5.5.6 Remote control

Note:
It is supported by some devices.
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IP Camera

Camera Remote

Network

Event Leamn Remote 'I | Learn | ‘ Clear |
Storage
Arm/Disarm |Arm =l |1Gs =l

> General
> Account
> Default
> Import/Export

> Auto Maintain

> Upgrade

Information

Figure 5-112
Parameter Function
Learn Bind remote control or wireless alarm with equipment.
Clear Unbind remote control with equipment.

Start arm after the time you choose, disarm comes into effect immediately. Note:

Arm/Disarm With disarm status, all the following alarms won't trigger: motion detect alarm,
masking alarm, local alarm, PIR alarm, wireless alarm.

5.5.6 Auto Maintenance

The auto maintenance interface is shown as in Figure 5-113.

Here you can select auto reboot and auto delete old files interval from the dropdown list.
If you want to use the auto delete old files function, you need to set the file period.

IP Camera

Camera Auto Maintain
NEtworx [¥] Auto Reboot Tuesday

Event
[T Auto Delete Old Files

Manual Reboot

Storage

> General |

Refesh || Save

> ount

> ttings
> Default

> Import/Export
> Upgrade

Information

Figure 5-113
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Parameter

Function

Auto Reboot

Check it and set auto reboot time.

Auto Delete Old
Files

Check it and set period within 1~31 days.

5.5.7 Upgrade

The upgrade interface is shown as in Figure 5-114.
Please select the upgrade file (file extension is “.bin”) and then click the update button to begin firmware

update.
Important

Improper upgrade program may result in device malfunction!

IP Camera

Camera
Network
Event

Storage

> Default

> ImportExport

Information

Upgrade

Select Firmware File

Figure 5-114

5.6 Information

5.6.1 Version

The version interface is shown as in Figure 5-115.
Here you can view system hardware features, software version, release date and etc. Please note the
following information is for reference only.

IP Camera

Camera
Network
Event

Storage

System

> Online User

Version

Software Version 2.420.0001.0.R, build : 2015-03-28
WEB Version 3.2.1.258363
ONVIF Version 242

SN YZC4DZ021W00009

Copyright 2015 All Rights Reserved.

Figure 5-115
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5.6.2 Log
Here you can view system log. See Figure 5-116.

IP Camera

Camera

Natwork StanTime | 2015 - 03 - 25 || 10 : 02 EndTime | 2015 -
= g
o HNo. Log Time User Name Event
M 411> MGoTo ®
Figure 5-116
Please refer to the following sheet for log parameter information.
Parameter | Function
Start time Set the start time of the requested log. (The earliest time is 2000/1/1)
End time Set the end time of the requested log. (The latest time is 2037/12/31)
Type Log type.
Search You can select log type from the drop down list and then click search
button to view the list.
You can click the stop button to terminate current search operation.
Log You can select one item to view the detailed information.
information
Clear You can click this button to delete all displayed log files. Please note
system does not support clear by type.
Backup You can click this button to backup log files to current PC.

5.6.3 Online User
The online user interface is shown as in Figure 5-117.
Here you can view current online user, group name, IP address and login time.
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IP Camera

Camera Online User
Network

Address

User Local Group User Login Time
admin admin 10.349.220 2015-03-26 09:45:22 =
Storage i admin admin 10.347.148 2015-03-26 09:55:14

System

Event 1

Figure 5-117
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6 Alarm

Please note some series product does not support this function.
Click alarm function, you can see an interface is shown as in Figure 6-1.
Here you can set device alarm type and alarm sound setup.

e | pwose [ __sewp ] s [ iogout ]
®

IP Camera

Alarm Type No. Time Alarm Type Alarm Channel

[] Motion Detection
7] DiskError

["] Exernal Alarm
[7] Audio Detection

[C] Scene Changing
‘Operation

[7] Prompt
Alarm Tone

[7] Play Alarm Tone

Tone Path

[] DiskFull

[7] video Tampering

[7] Megal Access

[ s

Figure 6-1

Please refer to the following sheet for detailed information.

Type

Parameter

Function

Alarm
type

Motion detection

System alarms when motion detection alarm
occurs,

Disk full System alarms when disk is full.

Disk Error System records alarm info when disk error
happens.

Video System alarms when video is tampering.

Tampering

External alarm Alarm input device sends out alarm.

lllegal Access System alarms when there is illegal access.

Audio Detection

System alarms when there is audio detect.

IVS

System alarms when IVS event is triggered.

Scene Changing

System will record alarm info when triggering
scene changing.

136



Type

Parameter

Function

Operation

Prompt

.|

When alarm is triggered, there will be s ==
inmain menu of alarm interface and system
automatically records alarm info. The icon
disappears when user click on alarm menu bar.
Note:

If alarm interface is displayed, when alarm is
triggered, there will be no image prompt, but alarm
record will be in list on the right.

Alarm
Tone

Play Alarm Tone

Click it and select the path of audio file to be
played in the tone path, when the subscribed alarm
event triggers, it will play the selected audio file to
prompt that there is alarm event which has been
triggered.

Tone Path

You can customize the storage path of the alarm
tone.
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7 Log out

Click log out button, system goes back to log in interface. See Figure 7-1.

Usemame: | admin

Password:

Figure 7-1
Note:
® This manual is for reference only. Slight difference may be found in user interface.
® All the designs and software here are subject to change without prior written notice.
® All trademarks and registered trademarks mentioned are the properties of their respective
owners.
® If there is any uncertainty or controversy, please refer to the final explanation of us.
® Please visit our website for more information.

www.dantesecurity.net

sales@dantesecurity.net

support@dantesecurity.net
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